




































































































































































Using the Resize Bar 

Most standard windows-especially those with scrollable contents-should have a resize 
bar. It gives users control of their environment by letting them choose how much screen 
space to devote to the contents of �t�h�~� window. 

If a window has a resize bar, you should be careful that the window remains as useful and 
attractive as possible, no matter how small or large it becomes. Each window can constrain 
its shape so that it doesn't become too big or too small, or so that it grows and shrinks in 
unit amounts. For example, the Workspace Manager File Viewer grows and shrinks only 
by the width of its browser columns, which eliminates the possibility of showing only a 
partial column. 

Using the Miniaturize Button [CJ 

Except when an application is useless without a particular standard window, each standard 
window should have a miniaturize button. When a window is miniaturized, it should 
remain miniaturized until the user explicitly unminiaturizes it. 

Because a miniaturized window isn't likely to be foremost in the user's thoughts, the 
application should never alter a miniaturized window without the user's knowledge. 
However, it's fine for an application to continue doing some work in a miniaturized 
window, as long as the user requested that the work be done. For example, the Terminal 
application completes commands that the user entered in a Terminal window. But it's 
unacceptable, for example, to change the font in a miniaturized window unless the user 
specified a font change for all windows. 

The miniaturize button has a counterpart command in the Windows menu that miniaturizes 
the key window. You can also provide a command in the Document menu that miniaturizes 
several related windows into a single mini window. See "The Windows Menu" and "The 
Document Menu" in Chapter 6 for information on how these commands work. 
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Using the Close Button ~ 

Most standard windows have a close button. However, sometimes the close button isn't 
necessary. For example, the Digital Webster application is useless if its only standard 
window isn't visible, so the window has no close button. 

Your application should break the close button ~ whenever the user would lose work by 
closing the window. From the user's point of view, a broken close button means that the 
application won't let the user lose work by accidentally closing the window. If the user tries 
to close a window that has a broken close button or tries to quit its application, the 
application should bring up a Close or Quit panel, respectively. (See Chapter 5 for more 
information on these standard panels.) 

Note: If an application uses multiple windows to display a single file, then all the windows' 
close buttons should break when unsaved work is in any window. However, the application 
shouldn't bring up a Close panel until the user closes the last window for the file. 

An example of breaking the close button is in the Mail application. Mail breaks a Send 
window's close button as soon as the user types in the message area of the window. If the 
user then tries to close the window (either directly or by quitting the application), Mail puts 
up an attention panel that makes the user either confirm that the window should be closed 
or cancel the close. 

If an application does no work that can be saved, but merely shows data that can change, 
then it can break the close button to show that the window isn't up-to-date. The application 
should also provide a way for the user to force the window to update. Workspace Manager 
uses the close button this way. 

Like the miniaturize button, the close button has a matching command in the Windows 
menu. The command has a keyboard alternative, Command-w (for "window"). (See "The 
Windows Menu" in Chapter 6 for details.) 
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Implementing Window and Application Status 

Most aspects of window and application status are handled automatically. However, you 
still must choose the first key window and decide which windows can become key 
windows. (For information on when to make a panel the key window, see Chapter 5.) The 
application should also activate itself in the appropriate way, as discussed below. 

Choosing the Key Window 

In general, all the standard windows in your application should be permitted to become the 
key window, even if they don't respond to keyboard actions. Giving key-window status to 
a window focuses attention on it and prevents the user from typing in any other window. If 
the key window doesn't do anything with the user's typing, it should beep as it receives the 
keystrokes to indicate to the user that typing isn't appropriate. 

When an application is activated on startup, it should designate one of its windows to be the 
initial key (and main) window. If the application opens a document file for the user, the 
window that displays the document should be the key window. 
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Activating an Application 

Usually, an application doesn't have to explicitly activate or deactivate itself. When your 
application exchanges messages with the Workspace Manager, uses services, or provides 
services, application activation and deactivation are handled by the system. For example, 
when the user chooses the Mail Selection service from Edit's Services menu, the Edit 
application is deactivated. Mail is then activated on condition that no other application is 
currently active. Since the Edit has been deactivated, this condition will be met, unless the 
user has activated another application in the meantime. All this happens automatically. 

The only time an application should need to explicitly activate or deactivate itself is when 
it communicates with another application without using the services system or the 
Workspace Manager. This might happen when two applications work together closely by 
sending messages directly to each other. If the intent of a message is to activate the 
receiving application, then the sender of the message should deactivate itself just before 
sending the message, and the receiver should conditionally activate itself when it receives 
the message. If the intent of a message is not to activate the other application, then neither 
application should activate or deactivate itself. In general, a message should conditionally 
activate the receiving application if the user might need to work in it-even if only to 
operate a scroller. 

Important: Applications should avoid activating themselves unconditionally. 
Unconditional activation violates the principle of user control, since it ignores the user's 
desire to turn to something else. 

Programming Note: Activating and Deactivating an Application 

As described in the section "Activating an Application," most applications don't need to 
explicitly activate or deactivate themselves. However, when necessary, an application can 
conditionally activate itself with the following code: 

[NXApp activateSelf:NO]; 

An application can deactivate itself as follows: 

[NXApp deactivateSelf]; 
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Avoiding Activation when Dragging 

When a user drags an object such as a color or file between two applications, both the area 
that originally contains the object (the source) and the area that the object is being dragged 
to (the destination) need to be visible. Sometimes the user needs to move the windows of 
one or both applications to make this true. Once the user starts to drag the object, it can be 
inconvenient for the applications' windows to change their ordering, since that can cause 
the destination to be covered. But if the source's application isn't active when the user starts 
dragging, the standard response would be to activate it, which would bring the application's 
windows forward and perhaps cover the destination. 

To avoid covering the destination, an exception to the standard activation behavior is 
necessary: When a user drags an object from one application to another, the source's 
application should not become active as a result of the dragging operation. However, the 
source's application should activate as usual when the user clicks anywhere in the source's 
window or begins a drag anywhere in the window except the source area. 

Avoiding activation when dragging objects is fairly simple to implement. First,each 
View that contains draggable objects shouldoverride acceptsFirstMouse so that it 
returns YES. This enables the View to receive events whether or not its window is the 
key window. Next, the View should override the shouldDelayWindowOrderingForEvent: 
method so that it returns YES when the passed mouse-down event occurred over a 
draggable object. (The shouldDelayWindowOrderingForEvent: message is sent just 
before the mouseDown: message for the event.) 

That's all you have to do if you use the dragging system. The dragging system 
automatically calls the preventWindowOrdering method (which prevents the 
window's application from being activated) if the object is dragged. Unless the 
preventWiridowOrdering method is called, the window's application is activated, 
as usual. 
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5 Panels 

Panels support the work done in the principal windows of an application. Like menus, most 
panels are vehicles through which the user can give instructions to the application. But 
unlike menus, they aren't restricted to a single column of commands: A panel can provide 
the user with a variety of different control objects-buttons, sliders, text fields, and more­
arranged as best suits its purpose. The Font, Find, Page Layout, and Open panels are all 
examples. Such panels can be viewed as generalized and more versatile menus. 

Some panels playa different role, however. Instead of letting the user give instructions to 
the application, they give information to the user. Help panels, the Info panel, and attention 
panels that display warnings are examples. 

What unites all panels-whether they convey instructions from the user to the application 
or information from the application to the user-is that they play conventional, supporting 
roles. Unlike windows, none of them is a site for the user's main work in the application. 
In a panel, the dialog between the application and the user is highly structured in both form 
and content. 

This chapter first describes the basic attributes of ordinary panels, and then describes how 
attention panels are different. The last section gives guidelines on creating your own panels 
and using the ones supplied by the Application Kit. 
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How Panels Work 

Because panels are a type of window, many of their characteristics are discussed in 
Chapter 4, "The Window Interface to Applications." Only the unique characteristics of 
panels are discussed in this section. 

Ordinary Panels 

Ordinary panels-those that aren't attention panels-look and act very much like standard 
windows. They're typically in the same tier as standard windows, so they compete with 
them for screen space. They have title bars just like standard windows, although panels 
don't usually have miniaturize buttons. However, ordinary panels differ from windows in 
a number of ways: 

• They can never be the main window. 

• They shouldn't become the key window unless they accept characters from the 
keyboard. 

• They generally aren't visible unless they belong to the active application-they rarely 
persist on-screen once the application has been deactivated. 

In addition, some ordinary panels are in a tier above standard windows, as discussed later 
in "Floating Panels." 

76 Chapter 5: Panels 

Programming Note: Creating Panels 

The Application Kit contains several ready-made ordinary and attention panels that you 
can use, as well as functions that let you easily create basic attention panels. You can also 
create custom panels-either ordinary panels or more complex attention panels. If you 
create a custom attention panel, you are responsible for making sure that the panel looks 
like an attention panel. (Similarly, custom ordinary panels should look like ordinary 
panels, and not like attention panels.) 



application icon 

Attention Panels 

An attention panel demands attention from users by denying them the ability to work in any 
other window of the active application. Until it's explicitly dismissed, the panel limits what 
the user can do within the application to just rearranging windows. Nothing else-title bar 
buttons, text entry, miniwindows, or controls in other panels-will work. The only menu 
commands that work are those that can affect the panel itself-for example, Cut, Copy, and 
Paste, if the panel includes a text field. 

It's possible to activate another application while an attention panel is on-screen, but when 
the user returns to the previous application, the mode created by the attention panel is still 
in effect. 

An attention panel differs from ordinary panels in the following ways: 

• It has an empty title bar. 

• It's closed by one or more buttons in its content area, not by a button in the title bar. 

• It stays on-screen-even when the application isn't active-until dismissed by the user. 

• It's the key window whenever the application is active. 

• It's isolated in a tier above everything on the screen except spring-loaded windows such 
as pop-up lists. 

Attention panels come up centered in the upper part of the screen, so the user can't overlook 
them. (The user can move them out of the way, though.) 

Because an attention panel sets an exclusive mode for itself, in effect disabling the rest of 
the application, it must be unmistakable and immediately apparent to the user. Some of the 
features that distinguish attention panels from other windows are illustrated below. 

bold, larger than usual type 

a way to cancel 

empty title bar 

default choice in the 
lower right corner 

Attention panels are dismissed from the screen as soon as the user takes the required action, 
which can be as simple as typing Return. When dismissed, the panel's mode ends. 
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Implementing Ordinary Panels 

Ordinary panels can be used in many ways, so you have many choices when implementing 
them. This chapter discusses the conventions for ordinary panels that are different from 
those for standard windows. 

Window Considerations 

Although ordinary panels are similar to standard windows, conventions for title bar buttons 
and key-window status differ slightly from those for standard windows. For more detailed 
information on the title bar buttons and on key windows, see "Implementing Windows" in 
Chapter 4. 

Using the Resize Bar 

If resizing the panel might be useful, then it should have a resize bar. Like a standard 
window, a panel should constrain its shape if necessary to prevent the panel from becoming 
a size that's too large or too small. 

Using the Miniaturize Button 

A panel can have a miniaturize button, but it's rare that one would be needed. Like menus, 
panels can be closed and returned to the screen through a menu command. A miniaturize 
button is redundant unless a mini win dow would, for some reason, be more convenient for 
the user than the command, or unless the panel persists on-screen when the application isn't 
active (see "Persisting Panels," later in this chapter). 

Using the Close Button 

Every ordinary panel should have a close button so the user can dismiss the panel when it's 
not needed. The close button is never broken, since panels don't contain the main work of 
the application. 
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Becoming the Key Window 

An ordinary panel should become the key window only if it accepts keystrokes (typing) or 
if it's used independently of any other windows. For example, the Find panel becomes the 
key window so that the user can type in the word to be found. But the tools palette in a 
graphics application should never become the key window because it's operated only by the 
mouse and it's always used in conjunction with a document window. On the other hand, 
the standard Info panel should become the key window because it contains information 
that's independent of the application's other windows. In other words, it's the center of the 
user's attention and thus should be the key window. 

A panel that accepts keystrokes can delay becoming the key window until the user indicates 
a readiness to begin typing (such as by clicking in a text field), provided that both of the 
following are true: 

• Text entry is not essential to using the panel. 
• Users typically don't enter text when using it. 

This is likely to be the case if most of the control devices in the panel are not text fields 
(they are buttons, selection lists, and so on) and if the choices that can be made by entering 
text can also be made in an alternative way (for example, by selecting items from a list). 
The Font panel is an example. This kind of panel should not show any selection until the 
user indicates a readiness to begin typing. 

Programming Note: Avoiding Key-Window Status 

Panels that need to avoid becoming the key window until the user indicates a readiness 
to begin typing can use the setBecomeKeyOnlylfNeeded: method of the Panel class to 
do so. 

However, panels that should never become key-a tools palette, for example-must use 
a different way to avoid becoming the key window. Each panel must remove key-down 
andkey-up events from itsevent mask. 
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Relinquishing Key-Window Status 

A panel should remain the key window only as long as necessary. If user actions within the 
panel affect the main window, key-window status should be returned to the main window 
as soon as those actions are completed. 

For example, when the user clicks the Set button (or types Return) in a Font panel to change 
the font of the current selection in the main window, the panel gives up key-window status 
(if it had it). In all likelihood, the user is finished with the Font panel (at least until the 
selection has changed) and is ready to resume working in the main window. Under these 
circumstances, the user should be free to begin working in the main window immediately, 
without being forced to click in it just to make it the key window. 

Exceptions to Ordinary Panel Behavior 

In general, ordinary panels are unobtrusive. They're in the lowest tier on-screen, and they 
disappear when their application is deactivated. Sometimes, though, an ordinary panel 
needs to be more prominent, as described in the following sections. 

Persisting Panels 

By default, an ordinary panel is removed from the screen when its application is 
deactivated. The user sees only panels related to the active application. This prevents 
confusion-such as might arise when similar Find panels for two different applications are 
on-screen at once. 

An application can override this default behavior and allow a panel to remain on-screen 
after the application has been deactivated, but only if the panel contains information 
that would be pertinent to the user's activities in another application. This should be a 
rare occurrence. 

An example is the Workspace Manager Info panel, which contains system-level 
information such as the amount of memory in the computer. Because the user might want 
to copy this information down-for example, into a mail message-this panel persists even 
when the Workspace Manager is deactivated. 

80 Chapter 5: Panels 



Floating Panels 

Ordinary panels are normally in the same tier as standard windows. Sometimes, though, 
it's useful to have a panel float above all other standard windows and ordinary panels. For 
example, a small panel containing a palette of drawing tools is most useful if it floats above 
the application's other windows. An example of a palette is below. 

Tools :2SJ 

" Q9 .~ ~ 
A ." ) Q 

A panel should be allowed to float above standard windows only if it passes all four of the 
following tests: 

• It's oriented to the mouse rather than the keyboard. Thus a panel that can become the 
key window should not be made a floating panel, unless it becomes the key window only 
when the user is ready to type (see "Becoming the Key Window" earlier in this chapter). 

• It's important that the panel remain visible while the user works in the application's 
standard windows. This test is passed if the user must frequently move the cursor 
from a standard window to the panel and back again (as for a tool palette) or the panel 
gives information relevant to the user's actions in the standard window (as in some 
inspector panels). 

• It's small enough not to obscure much of what's behind it. 

• It doesn't persist (remain on-screen) when the application is deactivated. 

Thus, panels float for some of the same reasons that menus do. 

Panels with Variable Contents 

Two types of ordinary panels-multiform panels and inspector panels-are used in 
many applications to show specialized information in a limited amount of space. Both 
multiform and inspector panels can be used for many different purposes, even within the 
same application. 
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Multiform Panels 

A multiform panel is a panel that has a pop-up list or set of graphical radio buttons at the 
top that lets the user choose which form the panel takes. For example, the following panel 
lets the user choose anyone of seven different forms. 

a.pplications viiI! be 
~-~-~---!Iaunched at startup 

tirne 

;r'R~;,1~tt":1 

::Shelf :~I 

Multiform panels conserve screen space by combining many related panels into a single 
panel. Since all their contents aren't visible all the time, multiform panels shouldn't be used 
for an application's most basic functionality. 
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Inspector Panels 

An inspector panel is any panel that displays information about the object that's currently 
selected. Inspectors usually let the user set properties of the object, as well. The Font panel 
(described in "Standard Panels" later in this chapter) is an inspector panel. It displays 
information about the font of the current selection. The Workspace Manager Inspector 
panel (shown below) lets the user see and set information about the currently selected file 
or folder. Inspectors are often multiform panels, with each form displaying a different kind 
of information about an object. 

l~ NeXTlogo.eps 
~r 

, , 

Path: Ime ' 
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Implementing Attention Panels 

Attention panels are appropriate in only a limited number of situations. Because they create 
a mode that severely limits the user's freedom of, action, their use should be restricted as 
much as possible. A panel can be made an attention panel when: 

• It gives the user information about the current context. Such panels usually warn of an 
error, of a potentially dangerous or unexpected result of the user's current course of 
action, or of a condition that makes it impossible to carry out a requested action. But 
they may also simply supply information the user will need to proceed intelligently with 
the application. 

• It interrupts an action to give the user an opportunity to take corrective steps-as, for 
example, the panel that interrupts the Quit command to let users save altered files before 
the application terminates. 

• It clarifies or completes a user action-as, for example, the panel that completes the 
Save As and Save To menu commands. (In this case, the menu command must have 
three dots after its name-for example, "Save As ... ". This is discussed under 
"Commands that Bring Up Panels," in Chapter 6, "Menus.") 

Attention panels that interrupt or complete an action must have a Cancel button. The 
Cancel button gives the user the option of canceling the action, in which case it should be as 
if the user had never initiated the action in the first place. Panels that inform or warn should, 
if possible, let the user choose what to do in response to the information they convey. 

Naming an Attention Panel 

Attention panels that come up as the result of a command or a commandlike user action 
should be named after the action that brings them to the screen. For example, the panel that 
appears as the result of choosing a Save, Save As, Save To, or Save All command should 
be named Save. The panel that comes up when the user wants to close an edited but unsaved 
document should be named Close, whether it's invoked from the close button or through 
the Close or Close Window commands. The panel's name appears just to the right of the 
application icon, as shown in the following figure. 
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Save changes to MyApp? 

The Default Option in an Attention Panel 

When a user action brings up an attention panel with a variety of choices, the default button, 
the one in the lower right comer of the panel, should allow the user to easily carry through 
with the action. It should not contradict what the user set out to do. Specifically, it should 
not be the Cancel button. 

The default button should not perform any additional action not implied by the user request 
that brought up the panel. In general, it should be the safest of the alternatives (for example, 
Open Copy rather than Open Anyway when the user tries to open a document that 
someone's already opened). 

The default button in an attention panel should normally be operable by pressing the Return 
key on the keyboard (when the panel is the key window). If so, it should be marked by the 
Return symbol~. However, if the button has dangerous side effects, it's acceptable to 
require that the user press the button. 

Dismissing an Attention Panel 

Each action that can dismiss an attention panel is represented by a separate button inside its 
content area. In contras"t, an ordinary panel is closed only by its close button (or the Close 
Window command), never by a button in the content- area. 

The buttons that dismiss an attention panel should be located along the right and lower 
edges of the panel, with the default button in the lower right comer. No button except for 
the default button should be operable by the Return key. 
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Naming Buttons in an Attention Panel 

When naming buttons in an attention panel, you should label each one clearly with a verb 
or verb phrase describing the action it performs. The user shouldn't have to read the text 
of the attention panel to be able to choose the right button. Thus, generic labels (like Yes 
and No) aren't appropriate, as they tend to cause user errors. Avoid using OK unless it's the 
only button in the attention panel. 

Good names for attention panel buttons include: 

86 Chapter 5: Panels 

Cancel 
Close Anyway 
Don't Close 
Don't Save 
Explain 
Open 
Open Copy 
Open Anyway 
Quit Anyway 
Replace 
Revert 
Review Unsaved 
Save 
Save All 
Set 



Optional Explanations in an Attention Panel 

An Explain button can offer users a way of getting more information before dismissing the 
panel. A typical example is shown below. 

1~1 Error 

You cannot delete all the cells in a table. 

r ----------------------------- --- - -

liF;1 Error 

You cannot delete all the cells in a table. 

A table must contain at least one cell. If you want to 
delete the table itself, then select the table and press 
the Delete key. 
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Standard Panels 

Some panels show up in many different applications. For example, every application must 
have an Info panel, which gives certain kinds of general information about the application. 
Text processing applications also have a Font panel, which lets the user set the font of the 
text selection. . 

This section describes all the standard panels. Some of them you have to create from 
scratch, using the guidelines in this section. Others are provided by the Application Kit. If 
a standard panel exists for functionality in your application, you should use it rather than 
designing your own. 

You can customize Application Kit panels, if necessary, by adding controls and information 
to what the Application Kit provides. For example, the Open panel on the left, below, has 
a check box added to it. Compare it to the normal Open panel on the right. 
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Programming Note: Customizing Application Kit Panels 

To customize panels that are implemented by the Application Kit, you should first 
construct a View containing the information and controls you want to add. You can then 
add the View by sending it to the panel in a setAccessoryView: message. 



The following table lists and describes the standard panels. After the table are sections 
describing how to implement each panel that isn't completely implemented by the 
Application Kit. 

Panel 

Close 

Colors 

Find 

Font 

Help 

Info 

Description 

An attention panel that should come up when the user tries to close 
a document that has unsaved changes. See "Implementing the Close 
Panel," later in this chapter, for more information. 

An ordinary panel that's provided by the Application Kit. It lets 
the user preview and specify colors in any of the following 
modes: color wheel, grayscale, red-green-blue (RGB), 
cyan-magenta-yellow-black (CMYK), hue-saturation-brightness 
(HSB), custom palette (which loads an image from which the user 
can choose colors), and custom color lists . 

. A Colors panel sometimes works with color wells. See "Color 
Wells" in Chapter 7, "Controls," for information on color wells. See 
"The Font Menu" in Chapter 6 for information on the command that 
brings up the Colors panel. 

An ordinary panel that lets the user enter a string for an application 
to search for. See "Implementing the Find Panel," later in this 
chapter, for more information on this panel. 

An ordinary panel that's provided by the Application Kit. It lets the 
user preview fonts and change the font of the currently selected text. 
See "The Font Menu" in Chapter 6 for more information on the 
interface to fonts. 

An ordinary panel that's provided by the Application Kit. You 
should use this panel to display anyon-line help provided by your 
application. This panel displays information that can contain text, 
graphics, and link buttons (which lead to other information). See 
"U sing the Help Panel," later in this chapter, for information on 
creating help. 

An ordinary panel that displays information about the application. 
See "Implementing the Info Panel," later in this chapter, for more 
information on this panel. 

( continued) 
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Panel 

Link Inspector 

Open 

Page Layout 

Preferences 

Print 

Quit 
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Description 

An ordinary panel that's provided by the Application Kit. It lets the 
user get and set attributes of the selected linked information. If your 
application's documents can receive linked information, then it 
should have this panel. See "Using the Link Inspector Panel," later 
in this chapter, for more information. "The Link Menu" in Chapter 6 
has more information about links. 

An attention panel provided by the Application Kit. It lets the user 
specify the name of a file to open. See "Using the Open Panel," later 
in this chapter, for more information. The Document menu's Open 
command brings up this panel, as described in Chapter 6. 

An Application Kit panel that queries the user for information that's 
needed for displaying the document on-screen, as well as for 
printing. It's brought up by a command in the Format menu, as 
described in "The Format Menu" in Chapter 6. This panel can be 
replaced by one more appropriate to your application, especially if 
your application has extensive page layout capabilities. 

An ordinary panel that allows the user to determine details of how 
the application looks and works. See the section, "Implementing the 
Preferences Panel," later in this chapter, for more information. 

An attention panel that's provided by the Application Kit. This 
panel comes up every time the user prints a document or other data. 
After specifying the information needed for printing, the user can do 
any of the following: send the output to a printer; save the output to 
a PostScript file, instead of printing it; send the output to a fax 
modem, instead of a printer; preview on-screen what will be printed; 
cancel any of the above actions, even after they've started. The main 
menu's Print command brings up this panel, as described under "The 
Main Menu" in Chapter 6. 

An attention panel that should come up when the user tries to quit an 
application that has unsaved or uncompleted work. See 
"Implementing the Quit Panel," later in this chapter, for more 
information. 
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Panel 

Save 

Spelling 

Description 

An attention panel that's provided by the Application Kit. It queries 
the user for the name of a file to save to. See "Using the Save Panel," 
later in this chapter, for more information. See "The Document 
Menu" in Chapter 6 for information on when the Save panel is used. 

An ordinary panel provided by the Application Kit to help the user 
check the spelling of text. See "Checking Spelling" in Chapter 6 for 
more information. 

Implementing the Close Panel 

When the user closes a document that has been edited but not saved, the application must 
bring up a Close panel giving the user an opportunity to cancel the operation, save the 
document before closing, or confirm that it should be closed without saving. This attention 
panel should have at least these three buttons: 

Cancel Don't Save Save 

Save is the default option because many users don't think of closing a document and saving 
the most recent changes to it as separate operations-for many, closing implies saving. 

If closing a document or window has consequences other than that unsaved changes would 
be lost, the application must still bring up a Close panel informing the user. For example, 
when the user closes a terminal emulation window, the application should notify the user 
that closing the window will cause the running command to be terminated. If the panel 
can't offer the user any way of avoiding the side effects, it should have these buttons: 

Cancel Close Anyway 

Note: Do not bring up a Close panel unless work is about to be lost. 
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Implementing the Find Panel 

This ordinary panel should have at least a text field to enter the search string and a button 
to find the next instance of the string. It's also good to have a button for finding the previous 
instance of the string. 

Note: Although we recommend that buttons have verbs as titles, it isn't appropriate in the 
panel above, for two reasons. First, changing the titles to Find Previous and Find Next 
hides the real difference between the buttons; it's easy to miss the second word in a button. 
Second, since Find is already mentioned in the panel twice (and no other verb is), it's 
redundant to put Find in the button titles. See "Choosing the Button's Image or Label" in 
Chapter 7 for more information on naming buttons. 

Many Find panels have more controls than the one shown above, such as the following: 

• A check box that lets the user choose whether capitalization matters (by default, it 
shouldn't) 

• A check box to choose whether partial words should be considered matches (by default, 
they should) 

• A Replace With text field (and related buttons-see Edit for an example) so that the user 
can replace the selected string 

• Radio buttons that determine the scope of global searches or replacements (by default, 
the scope should be global rather than just the selected region) 

• Options for finding objects other than strings (such as paragraph characteristics) 

Although the Find panel usually stays up until the user explicitly closes it, it's common to 
dismiss the panel early in one case. This case is described in "Determining the Action that 
Is Performed" in Chapter 3, "User Actions: The Keyboard and Mouse." 

The Find Panel menu command brings up this panel. The Find Next and Find Previous 
commands correspond to its two buttons. (See "The Find Menu" in Chapter 6.) 
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Using the Help Panel 

The Application Kit Help panel is part of the NeXTSTEP help system. Some of the 
information displayed by this panel is already provided by the help system. For example, 
every application has available to it ready-made help on using the NeXTSTEP user 
interface. Besides help on basic tasks, such as using menus and scrollers, the help system 
has skeletal help that's automatically displayed when the user Help-clicks in menus and 
panels that are implemented by the Application Kit. For example, when the user 
Help-clicks in the Print panel, some basic information on using the panel appears in the 
Help panel. 

To use the Help panel, you need to add information about the objects in your application 
and the tasks associated with them. You should also override the standard help for 
Application Kit panels and commands with new files containing links to more task-oriented 
help. Once you've added the information, you should modify the provided index and table 
of contents so that they refer to the information. 

Programming Note: Implementing On-Line Help 

The Help panel is one part of NeXTSTEP support for on-line help. Other support includes: 

• A question mark cursor that appears when the user presses the Help key (or on 
keyboards without a Help key, when both the Alternate and Control keys are pressed) 

• An easy way to connect interface objects with help text, so that when the user 
Help-clicks an object, information about the object automatically appears in the Help 
panel 

• Built-in help for basic tasks (such as using menus and operating scrollers) 

To add help to an application, you first add a help folder using Project Builder. This help 
folder includes template files for the Help panel's index and table of contents. You can 
create and modify these and other help files, along with the help links in them, with 
developer-mode Edit. Both Interface Builder and the Application Kit have support for 
associating help with the user interface objects in your application. 

For more information on implementing on-line help, see the NXHelpPanel discussion in 
the NeXTSTEP General Reference. 
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If your application uses the Help panel, it should also support Help-clicking of its objects. 
(Otherwise, when the user Help-clicks an object, the Help panel will come up but will likely 
show inappropriate help.) Help-clicking an object results in the panel automatically 
displaying the most specific help available. For example, when the user Help-clicks a 
button, the help system first looks to see whether the button has help associated with it; if 
so, the Help panel displays it. If not, the help system looks for more general help, such as 
that associated with the window or even the application that the button is in. 
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Writing Note: Creating On-Line Help 

You're encouraged to reuse the contents of the help in NeXT applications such as Edit, 
Mail, and Workspace Manager. After copying the contents from one ofthese applications' 
Help panels, you can paste the contents into a file in your application's- help folder. You 
should then modify the help text and update the help links it contains so that the help suits 
your application. For example, Edit has help on working with documents, text, graphics, 
and color, as well as on printing and faxing. With a few changes, much of this help is 
appropriate for other document-based applications. 

You're also encouraged to use the design of NeXT's help. Help in NeXT applications 
is task-oriented, with Help-clicking serving as a way of discovering the tasks an object 
is used for. At the end of every help file is a list of related tasks, with links to the help 
for each task. The objects that have associated help are generally menu commands, 
standard windows, panels, and a few important buttons such as those in Mail's 
Compose window. If supplying this level of help isn't practical, then you should at least 
ensure that Help-clicking any object results in help on a relevant subject, even if the help 
is very general. 



Implementing the Info Panel 

I .. .. It~fo _. ~ 

Structured Version 
)C"XF!" c!(Q ... illI by BerttendStrlet 

NeXT Text Editor 
by Bryan Yememoto 
Release 3.0 (,/72) 
Copyright 1992 by NeXT Computer, Inc. 

Each application must have an Info panel. This ordinary panel should display a small 
amount of basic information about the application: 

• The name of the application 
• The application icon 
• Copyright information 
• The current version of the application 
• The names of the authors (optional) 

The Info panel should not offer help for using the application or give an extensive amount 
of other information about it (such as its history or purpose). 

Interface Builder provides a sample Info panel that you can use in your application. 
See "The Info Menu" in Chapter 6 for information on the command that brings up the 
Info panel. 

Using the Link Inspector Panel 

When using this Application Kit panel, you should provide an accelerator for the panel's 
Open Source button: Double-clicking an item of linked information while pressing the 
Control key should have the same result as selecting the item and choosing the Open Source 
button. 
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Using the Open Panel 

If your application can open only certain types of files, then it should show only those files 
in this Application Kit panel. 

The Open panel should come up showing the folder of the most recent main window (since 
the application started up). If the application has had no main window since it started up, 
then the Open panel should show the user's home folder. 

Implementing the Preferences Panel 

Most applications have a Preferences panel, an ordinary panel that allows the user to 
determine details of how the application looks and works. A user typically uses this panel 
only a few times. It should not be necessary to bring up the Preferences panel during 
normal use of the application. 

Preferences typically include such things as: 

• The default font size 
• The format for displaying data 
• Whether to make backup files 
• The default size of windows 
• Options that increase the power of the application 
• The application's keyboard alternatives 

Do not use the Preferences panel for anything the user might want to set from time to 
time during a session. Also, the contents of the Preferences panel should be valid 
applicationwide: They shouldn't change depending on which window or data is selected. 
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All preferences should carry over from session to session; most will also affect the way the 
application works during the current session. All of an application's options must be 
settable in some way from within the application. For example, it isn't acceptable to have 
options that are settable only by using the dwrite command. 

Preferences panels are often implemented as multiform panels to reduce their size and to 
organize their options. The Preferences panel is brought up by the Preferences command in 
the Info menu. See Chapter 6 for information on the Info menu. 

Implementing the Quit Panel 

When the user tries to quit an application that has unsaved or uncompleted work, the 
application should bring up a Quit panel. For example, if the user has edited a document 
and not saved the changes, or if the application is still computing (for example, a command 
is executing in a UNIX shell), a Quit panel should appear. In both cases, one or more of 
the application's windows should have a broken close button, as described in "Using the 
Close Button" in Chapter 4. 

The Quit panel should be an attention panel that has the following buttons: 

• A Cancel button (only when the panel is brought up as the result of choosing the 
application's Quit command) 

• A Quit Anyway button 

• A Review Unsaved button (only for document-oriented applications) that cycles through 
unsaved documents, letting users decide which ones to save before quitting. 

The buttons are arranged as follows: 

Cancel Quit Anyway Review Unsaved 

An application could also add a Save All button that saves every unsaved document, exactly 
as the Save All command does. 

Important: Because applications can't cancellogouts and poweroffs, the Quit panel 
shouldn't have a Cancel button when it's brought up as the result of a logout or poweroff: 

Quit Anyway Review Unsaved 

Review Unsaved is the default button. It brings up a Review Unsaved panel for each 
unsaved document. This panel is essentially the same as the Close panel described above, 
though with a different name to reflect the different manner in which it's invoked. 
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The Cancel button in the Review Unsaved panel cancels the review process and returns the 
user to the Quit panel. Once the user has finished cycling through all the documents 
(without clicking Cancel), the application should quit. 

Note: Do not bring up a Quit panel unless work is about to be lost. 

Using the Save Panel 

This Application Kit panel should come up showing the folder of the document being saved 
(the document in the main window). A document's folder is reflected in its window's title 
bar. For example, if the title bar shows 

UNTITLED-1 - INet/machine/home 

then the Save panel should come up showing lNetimachinelhome. 
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Menus 

Menus provide users a point of entry for all the functionality of an application, its obscure 
and common features alike. Because of this special role, they behave in a special way: 

• All the visible menus for an application disappear when the user starts working in 
another application. They reappear when the user returns to the application. (Menus 
that weren't previously on-screen don't reappear.) 

• Menus are segregated into two of the frontmost tiers of on-screen windows. They 
appear to float above everything else on-screen except attention panels and 
spring-loaded windows such as pop-up lists. 

• Menus can't be miniaturized. They don't need to be, since they're small and can be 
easily retrieved after they've been closed. 

• Menus are hierarchically arranged. Choosing a command in one menu can produce 
another menu with its own list of commands. 

The first three of these points were discussed earlier in this manual. (See "The Active 
Application," "Window Order," and "Miniaturizing" in Chapter 4, "The Window Interface 
to Applications.") 

Applications should make use of the menu system's hierarchy to arrange commands 
in distinct, functionally identifiable menus. A well-defined set of hierarchical menus 
aids users both in finding the commands they need and in understanding the structure of 
the application. 
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How Menus Work 

main menu submenu 
v 

My App Services 

menu command - : Info t- lDetine in Webster shows that the command 
iDocumenf r-:: lMaH· ~ - brings up a submenu 
!Eell!' r--:. fbpetlin \\iOrkspabe -=-:..- a disabled command 

ff-lide" h ..... · -------- shows the keyboard 
I-i-!Q-U-It-~q~ alternative for the command 

The main purpose of menus is to provide commands for the user to choose. To choose a 
menu command, the user presses the mouse button as the cursor points anywhere within the 
content area df the menu and releases it as the cursor points to the desired command. This 
can be as simple as clicking the command, or the user can drag through the menu, from 
command to command. Each command that comes under the cursor while the mouse 
button is down is highlighted. 

Instead of using the mouse, the user can often use a keyboard alternative to choose a 
command. A keyboard alternative is a combination of a character and the Command key. 
For example, holding down the Command key and pressing the p key is the standard 
keyboard alternative for the Print command. Keyboard alternatives are discussed in detail 
in Chapter 3, "User Actions: The Keyboard and Mouse." 

The Main Menu 

Every NeXTSTEP application has at least one menu, its main menu. If an application has 
just a main menu, it holds all the commands for the application. If the application has more 
than one menu, all but the main menu are submenus of another menu. Through the 
hierarchical arrangement of submenus, the main menu gives the user access to all the menus 
of the application. 

Because the main menu is at the top of the menu hierarchy, it lacks a close button and 
always remains on-screen when its application is active. 

By default, when an application first starts up, its main menu appears in the upper left 
corner of the screen. Users can change this default location by dragging the main menu to 
a new position. Another way to change the default location for all applications (except 
those whose main menus have already been moved) is with the Preferences application. 
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Bringing the Main Menu to the Cursor 

If the user enables one of the mouse buttons (with the Preferences application), it can be 
used to gain quick access to the main menu. When the user presses the enabled mouse 
button (except when the cursor is over an application icon), a copy of the main menu for 
the active application appears under the cursor. The copy stays on-screen until the mouse 
butten is released. 
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Fig 

To begin, the cursor lies directly over the main menu's title bar. The user can drag down 
into the menu (and into its submenus) to choose a command. When the mouse button is 
released, the copy and any submenus disappear. 

See "Left and Right Orientation" in Chapter 3, "User Actions: The Keyboard and Mouse," 
for more information on enabling mouse buttons. 
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Submenus 

The main menu is the only menu in an application that isn't a submenu. Every other 
menu is a submenu of another menu, which is its supermenu in the application's hierarchy 
of menus. 

Each submenu is associated with a particular command in its supermenu. The submenu 
becomes visible and attaches to its supermenu when the user chooses the command that it's 
associated with. 

The user can drag from a controlling command into a submenu to choose one of the 
submenu's commands. As long as the mouse button is held down, the submenu remains 
visible and the controlling command stays highlighted. But once the mouse button goes up 
and the command has been executed, the submenu disappears. 
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Programming Note: Menus and the Application Kit 

The Application Kit takes care of everything discussed in this section, IIHow Menus 
Work." Specifically, it provides the following functionality: 

• All aspects of displaying and hiding menus and menu commands (although you must 
specify when a command should be disabled), including tearing off submenus 

• Letting you associate menu commands with menus 

• Making sure the keyboard alternative works 

• Detecting when the user chooses a menu command and reacting appropriately (such 
as by highlighting and bringing up a panel) 

Much of this functionality can also be accessed through Interface Builder. For example, 
to associate an application-specific command with a menu, the programmer can simply 
drag a menu command from the Palettes window into the menu. You can then change 
the name of the command, give it a keyboard alternative if necessary, and associate an 
action with the command. 



Keeping a Submenu Attached 

The easiest way to attach a submenu is simply to click its controlling command, but the user 
can also drag to the controlling command and release the mouse button while the cursor is 
still above it. The controlling command for an attached submenu stays highlighted to 
indicate that the submenu is attached. 

A supermenu and its attached submenu act like a single window. User actions that move 
or close the supermenu also move and close the submenu; an attached submenu has no close 
button of its own. A submenu attached to the main menu is assigned to the same window 
tier as the main menu. 

An attached submenu can also have its own attached submenu. This is illustrated below. 
The Librarian menu is attached to Services, and Services is attached to the main menu. 
Moving the main menu serves to move all three. 

Tearing Off an Attached Submenu 

The user can tear off an attached submenu by dragging it away from its supermenu. 
Moving it free of its supermenu gives it an independent life on-screen. As a sign of its 
independence, it gets, for the first time, its own close button. The close button identifies the 
menu as a tom-off submenu. (Any submenus that were attached to the tom-off submenu 
move with it and remain attached.) 

main menu 

detached menu 
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The idea is for users to bring up a submenu, then tear it off and move it to a desired location 
if they want it to stay on-screen. Once a submenu has been tom away from its supermenu, 
it stays where the user puts it. To reattach the submenu, the user must close it and then 
choose its controlling command. 

If the user presses the mouse button while the cursor is over the command that controls the 
tom-off submenu, a copy of the submenu temporarily appears next to its supermenu. 

temporarily 
attached menu . 

Removing a Submenu from the Screen 

Assuming its application is active, an attached submenu can be removed from the screen in 
three ways: 

• By again choosing its controlling command. Choosing the Librarian command in 
the detached Services menu in the previous figure causes the Librarian submenu to 
disappear. 

• By choosing any other command in the supermenu. 

• By removing its supermenu from the screen. For example, when a tom-off supermenu 
is closed, its attached submenu disappears from the screen. 

A tom-off submenu is removed from the screen by clicking its close button. 
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Commands 

A menu can display several different kinds of commands, all of which use the 
targeted-action paradigm. Some commands require the user to select the target-Copy, 
Paste, and Miniaturize Window, for example. Others-such as Hide, Quit, and Info-don't 
require a selection: The target is built into the program. 

When a command is chosen-whether it's clicked or activated by a keyboard alternative­
it's highlighted. Keyboard alternatives can also operate commands in off-screen menus. 
When they do, the menu's controlling command (or, if the supermenu isn't visible, the 
supermenu's controlling command) is highlighted. This ensures users of immediate, visual 
feedback that the keyboard alternative has in fact invoked the command. 

Some commands control submenus. The action of the command is simply to attach the 
submenu to the menu. These commands are marked by the submenu symbol [~'. 

Many commands cause panels or standard windows to appear on-screen: 

• Some bring up a standard window-the New command in the Document menu, for 
example, or the Console command in the Workspace Manager Tools menu. 

• Some put an attention panel on-screen to help clarify or complete the command. For 
example, the Save As command produces a panel that asks the user to type in the file 
name the user wants to use for the document. 

• Others bring up a panel that can stand on its own, independent of the command that 
produced it. Sometimes the panel simply imparts information to the user-a Help panel, 
for example. But usually it acts as a control panel where the user can give instructions 
.to the application-the Font and Find panels, for example. Such panels are similar to 
submenus in that they open a range of options to the user. 

If a menu command controls a submenu, it remains highlighted as long as the submenu is 
attached. If it controls an attention panel, it remains highlighted until the panel is dismissed 
from the screen. Commands don't stay highlighted if they bring up a panel that isn't an 
attention panel. 

The programmer can disable a command, as described later in this chapter in "Disabling 
Invalid Commands." Disabled commands have dark gray text (instead of the usual black) 
on the usual light gray background. They're completely inoperative and don't highlight in 
response to user actions. 
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Implementing Menus 

The Application Kit provides much of the user interface to menus, leaving you the task of 
determining application-specific characteristics such as: 

• The menu hierarchy 
• The names of menu commands 
• When each menu command is valid 
• Keyboard alternatives 

This section describes standards for the menu hierarchy and for naming menu commands. 
When a command isn't valid, it should be disabled, as described later in this chapter. 
Chapter 3 lists all the standard and recommended keyboard alternatives. 

Designing the Menu Hierarchy 

When designing your application's menu hierarchy, you should start with the standard 
menus described later in this chapter-in particular, the main menu. Having standard 
menus, as much as possible, is one of the easiest and best ways to ensure consistency 
between applications. 

Since menus need to be easily accessible to the user, you should try to keep your 
application's menu hierarchy as shallow as possible. In general, a menu should be located 
no more than two steps away from the main menu. It's even better to have menus no more 
than one step away, as long as they don't grow too long or confusing as a result. 

A menu should never have fewer than two commands unless it grows and shrinks 
dynamically and happens to shrink to fewer than two. If an application has a menu with 
only one item in it, that item should be bumped up one level and replace the command that 
brings up the menu. (A specific example of this is discussed later in this chapter under "The 
Info Menu.") 
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A menu can have as many submenus as it has commands, although only one at a time can 
be attached to the menu. A menu should appear only once in the menu hierarchy-it should 
not be the submenu of two menus. 

Choosing Command Names 

Command names should be short, consisting of a single word if possible, a short phrase if 
not. Avoid abbreviations in commands, especially those that aren't standardized or widely 
used. Applications in the same language should follow the same capitalization rules. For 
English, commands are capitalized as they would be in a title-the first and last words 
begin with uppercase letters, as well as major words in between. 

Each command name should be unique. No two comnlands, even if they're in different 
menus, should have the same name. 

Commands that Perform Actions 

Wherever possible, the first word of an action command should be a verb, so the command 
reads like a short imperative sentence for the action it performs. Examples include Hide, 
Open, Save As, and Revert to Saved. 

Some menu commands have different results, depending on the application's state. The 
name of such a command should change so that it always describes what the command will 
do. The clearest way to do this is to change the command's verb. Some examples of good 
names follow: 

First State 

Show Ruler 
Show Grid 
Use Grid 
Bold 

Second State 

Hide Ruler 
Hide Grid 
Ignore Grid 
Unbold 

Notes 

Don't use Grid On and Grid Off. 
Bold is treated like a verb in this command. 

Avoid using two menu commands instead of changing the menu command's name. For 
example, you shouldn't have a Show Ruler command followed by a Hide Ruler command, 
where one of the commands is always disabled. 
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Commands that Bring Up Panels 

With one exception, a command that always brings up a panel must have three dots 
immediately following its name (for example, "Preferences ... "). The exception happens 
when the panel is a warning panel-such as one that comes up when the user tries to revert 
to a saved version of a document. Because the user could complete the action if the warning 
panel weren't there, it's inaccurate to imply that the command brings up a useful panel. 
Also, users who are new to an application sometimes tend to look at all of its panels (by 
choosing menu commands with " ... "). You don't want to encourage users to choose 
commands that are so dangerous that they require warning panels. For example, the 
Workspace Manager Log Out command doesn't have three dots, even though it always 
brings up a warning panel. 

Do not put three dots after commands that only bring up a standard window (like the 
New Viewer command in the Workspace Manager, or the New command in the standard 
Document menu). 

Note: Use three periods (not the ellipsis character) to produce the three dots. 

If the purpose of a command is to perform an action, and the panel comes up only to help 
complete the action, then the command should be named for the action, not for the panel. 
(The panel is then given a name that reflects the command name.) In this case, use the 
guidelines for naming described earlier in "Commands that Perform Actions." For 
example, the standard Save, Save As, and Save To commands are action commands that 
happen to bring up a panel (which is called the Save panel). 

If the purpose of the command is to bring up the panel, then the command is named after 
the panel. This usually results in a noun phrase as a name, instead of the verb phrase that's 
usually used for action commands. For example, the Preferences command brings up the 
Preferences panel, and the Spelling command brings up the Spelling panel. 

A command that brings up a panel shouldn't usually have Panel in its name, since the three 
dots already indicate that it brings up a panel. However, you can add Panel if the 
command's name would otherwise be identical to another command's name. For example, 
when the command that brings up the Info panel is in the Info menu, the command is named 
Info ~anel. When an application has no Info menu, the command is named just Info. 
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Commands that Bring Up Submenus 

Commands that bring up submenus usually begin with nouns, but verbs or adjectives are 
acceptable if they're clearer. Every submenu command in a menu should have a name that's 
clearly different from every other command in the menu, so that the user can guess what 
each submenu contains by its name. For example, it's a bad idea to have under the main 
menu both a Tools menu and a Utilities menu, since most users won't be able to remember 
which is which. 

If a command brings up a menu of actions, it might be appropriate to have the command 
name the "target" of the actions. The Document menu uses this scheme: the Open 
command can be read as Open Document, the New command can be read as New 
Document, and so on. 

Commands that Bring Up Standard Windows 

A command that brings up a standard window should either start with New (as in the 
standard New command described under "The Document Menu," below) or match the title 
of the window. For example, the Workspace Manager has a New Viewer command under 
its View menu. 

Sample Command Names 

Some sample commands follow: 

Cut 
Font 
Font PaneL .. 
Hide 
Info Panel... 
New 
Preferences ... 
Save As ... 
Select All 
Show Graphics 

(performs an action) 
(attaches the Font menu) 
(brings up the Font panel) 
(performs an action) 
(brings up the Info panel; used only when Info is already used) 
(brings up a new document in a standard window) 
(brings up the Preferences panel) 
(an action command that happens to bring up a panel) 
(performs an action) 
(switches to Hide Graphics when graphics are already visible) 
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Disabling Invalid Commands 

When a menu command won't work, it should either be disabled or bring up an explanatory 
panel. For example, when a text editor has no documents open, it should disable its Save 
and Close commands, as shown below. 

When a disabled command is chosen using a keyboard alternative, a beep occurs. This 
helps the user know that the command isn't valid, even if the command isn't visible. 

If an invalid command brings up an explanatory panel, the panel should explain why the 
command is inappropriate and offer assistance. The panel must provide more information 
than just that the command won't work, since that information can more directly be 
conveyed by disabling the command. 

Graphical Devices in Menu Commands 

The area to the right of a command can be used only to display a keyboard alternative or a 
submenu symbol. (Commands that control submenus can't have keyboard alternatives.) 
No other graphical devices are permitted in this area. 

In addition, menu commands should not use arbitrary graphical devices, such as check 
marks, to show state. There's almost always a more appropriate way to display current state 
in our interface-for example, by using buttons or check boxes in a panel or by designing 
objects that can be directly manipulated (such as those in the Edit application's ruler). 
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Programming Note: Tools for Creating Menus 

Project Builder creates your application's main menu. You can add commands and 
menus using Interface Builder. Some standard commands provided by Interface Builder 
have actions or submenus already associated with them. For example, by dragging the 
Windows command from the Palettes window of Interface Builder into your application's 
main menu, you give your application the full functionality described in I'The Windows 
Menu," later in this chapter. 



Standard Menus and Commands 

There's a great deal to be gained if commands shared by most applications are arranged 
similarly in similar menus. This section gives the standard arrangement of menus and 
commands for NeXTSTEP applications. 

Note: This chapter shows the U.S. English command names. For each language, the 
standard command names should be consistent. For example, Quit is Quitter in every 
French application. 

The Main Menu 

Every application should layout its main menu as described in this section. 

Programming Note: Implementing Commands 

Many menu commands are standard, as described in this section, "Standard Menus and 
Commands." Many of these standard commands and much of their behavior are 
supplied by the Application Kit, Project Builder, and Interface Builder. The Application Kit 
even automatically changes the names of some commands, such as changing Bold to 
Unbold, and disables some commands when they're invalid, such as Heavier. (Both 
commands are in the Font menu, which is described later in this chapter.) However, you 
should double-check that each menu command works correctly. 
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The title of the main menu should be the name of the application, shortened somehow if the 
name is too long. For example, the main menu of Interface Builder is named IB because 
naming it Interface Builder would needlessly waste screen space. 
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Command 

Info 

Document 

Edit 

Format 

Action 

Attaches the Info menu, which contains commands that give general 
information about the application, as well as let the user set general 
preferences about how the application works. Info is the first command 
in the main menu in part because it can be read in conjunction with the 
application name in the title bar (for example, Info about Edit, Info about 
Draw, and so on). See "The Info Menu," later in this chapter. 

Attaches the Document menu, which has commands that affect a 
document as a whole-opening, saving, and closing, for example. This 
menu is named differently in different applications, so it's important that 
the command be in a prominent, well-defined location (second). See 
"The Document Menu," later in this chapter. 

Attaches the Edit menu, which contains commands affecting the current 
selection. Every application that can have editable documents or 
selectable text must have this menu. See "The Edit Menu," later in 
this chapter. 

Attaches the Format menu, which contains commands affecting the 
layout of documents, including the font and paragraph format of text and 
the arrangement of graphic images. See "The Format Menu," later in 
this chapter. 
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Command Action 

Windows Attaches the Windows menu, which contains commands affecting the 
windows that belong to the application. See "The Windows Menu," later 
in this chapter. 

Print... Brings up the Print panel, which permits the user to print or fax a 
. document. You can omit the Print command if your application doesn't 
print. In general, the Print command is assumed to print the document 
in the main window. If a panel can be printed (for example, one that 
contains a registration form), then to avoid confusion the panel might 
contain its own Print button. 

Services Attaches the Services menu. This menu lets the user choose services 
provided by the system or by other applications. See "The Services 

. Menu," later in this chapter. 

Hide Hides all the windows of the application. See "Hiding and Retrieving 
Windows" in Chapter 4. 

Quit Terminates the application. If quitting the application might cause 
the user to lose work, then the application should bring up a Quit 
panel. Otherwise, the application should not require confirmation of 
a Quit command. 

The Info, Services, Hide, and Quit commands should be in the main menu of every 
application. The other commands described above should be included when appropriate. 
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Adding to the Main Menu 

The main menu works best when it's short (so that commands are easy to find) and narrow 
(so that it doesn't take up much screen space). Applications should generally have no more 
than 11 or 12 commands in the main menu. 

The main menu is also, for the most part, a menu of menus. Commands that are added to 
the main menu should typically be ones that bring up submenus. 

When designing your application's user interface, you can move a command that the 
guidelines place in a submenu up one level to the main menu, provided that: 

• The main menu is short enough to accommodate another command. 

• The command provides functionality that's considered central, even crucial, to the 
application. For example, a text editor might bring the Font command up to the main 
menu from the Format menu, but a spreadsheet would not. 

Like any other command that's added to the main menu, a command that's raised from a 
submenu should generally control another submenu. 

When a command is promoted to the main menu, it should, for continuity, be located 
immediately after the command for the submenu it would otherwise be in. For example, 
if the Font command is raised from the Format menu, it follows the Format command. 
If the Find command is promoted from the Edit menu, it follows the Edit command, as 
shown below. 
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The Info Menu 

The Info menu contains commands that let the user get and set information about the 
application, as a whole. A License command is an example of the kind of command that 
could be added to this menu. 

Command 

Info Panel... 

Show Menus 

Preferences ... 

Help ... 

Action 

Brings up a panel that displays a small amount of basic information 
about the application. This standard panel is described in Chapter 5, 
"Panels." 

Displays and tiles all the application's menus. There's currently no 
support for this command in the Application Kit. You can 
implement it or not as you see fit. 

Brings up the application's Preferences panel, which permits the 
user to customize the application. This standard panel is described 
in Chapter 5. 

Brings up a panel with helpful information on how to use the 
application. If you implement this command, you should use the 
standard Help panel, which is described in Chapter 5. If you don't 
implement this command, then when the user Help-clicks an object 
in your application, the system brings up a panel informing the user 
that the application doesn't use the NeXT STEP help system. 

If an application doesn't support any of the commands in the Info menu except Info Panel, 
it should omit the menu and make the Info command bring up the panel instead. (The 
command would then be followed by three dots.) 
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The Document Menu 

This menu contains commands that affect a document as a whole. Commands affecting 
selected contents of a document are mainly in the Edit menu. Applications that don't open 
or save documents of some kind and don't have a New command don't have this menu. 

The title of this menu (the second command in the main menu) should indicate the kind 
of thing that the Open command opens and the Save command saves. It might be 
Document, Project, File, Model (for spreadsheets), Game (for games), or Shell (for a 
terminal emulator). Never call this menu Window, since a Windows menu is standard in 
most applications. 
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Command 

Open ... 

New 

Save 

Save As ... 

Action 

Brings up the Open panel so the user can open a file. Opening a file 
also opens a window (or windows) to display it in. 

Opens a new, unnamed file and a window to display it in. This new 
document should be in the same folder as would be displayed in the 
Open panel. (See the section "Using the Open Panel" in Chapter 5.) 

Saves any changes in the document displayed in the current main 
window to a file (writes them to the disk). If the document has never 
been saved to disk, this command should have the same effect as the 
Save As command. 

Saves the document displayed in the main window, as changed, by 
writing it to a new file with a name supplied by the user. The 
document displayed in the main window corresponds to the new file, 
and the window's title is changed accordingly. This command 
places a Save panel on-screen that asks the user to type in a file name 
or cancel the command. 

(continued) 



Command 

Save To ... 

Save All 

Revert to Saved 

Close 

Action 

Saves the document displayed in the main window, as changed, by 
writing it to a new file with a name supplied by the user. In this 
respect, Save To is identical to the Save As command. However, 
Save To doesn't replace the window's current file with the new one. 
You can choose whether to implement Save As or Save To or both in 
your application. 

Saves every document that's open in the application. This is a 
shortcut for performing the Save command on every open document. 

Replaces the current version of the document displayed in the main 
window with the version saved on disk. This undoes any changes 
made to the document since it was last saved. 

Closes the document in the main window, and all the windows used 
to display that document. In other words, it's completely parallel to 
the Open command. See "The Windows Menu," later in this chapter, 
for information on a related command, Close Window. 

If an application uses more than one window to display a document, it could add a 
Miniaturize command to miniaturize all the windows associated with the currently selected 
document (the document of the key window) into a single miniwindow. A standard 
command already exists (Miniaturize Window in the Windows menu) to miniaturize a 
single window. 

Performing an Implicit New Command 

If the user starts up an application by double-clicking an application icon rather than a 
document icon, the application should, if appropriate, provide the user with a new 
document to work in (performing an implicit New command). This is much friendlier to a 
new user than simply putting a menu on-screen. Users should be permitted to disable this 
behavior through a preference. 

It's almost always appropriate for general-purpose applications to perform an implicit New 
command. However, it's not appropriate if the application can't produce a new document 
without user input. It's also not appropriate if producing a new document has side effects, 
such as modifying the file system by creating a new folder or adding a file that might persist 
even if the user decided not to save the new document. 

When an application is started up automatically at login or from another application, it 
should not perform an implicit New command. 
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If the user opens another document without touching the new one that was provided at 
startup, the application could automatically close the new one. But this is not a requirement 
of the user interface. 

Uneditable Documents 

If a document is opened that the application won't allow the user to save (even with a Save 
As command), it should not permit the user to edit the document on-screen. Waiting until 
the user is ready to save changes is too late. 

The Edit Menu 

Edit 

1 Check Spelling 
[seled A Ii . a 

The Edit menu contains commands that alter the selection in the current key window (or in 
the main window if the key window doesn't respond to the command). Each command 
should be dimmed when it can't operate on the current selection. 
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Command 

Cut 

Copy 

Paste 

Action 

Deletes the current selection and copies it to the pasteboard. 

Copies the current selection to the pasteboard without deleting it. 

Replaces the current selection with the contents of the pasteboard. 

( continued) 



Command 

Paste As 

Link 

Delete 

Undo 

Find 

Spelling ... 

Check Spelling 

Select All 

Action 

Attaches a submenu that permits the user to paste the current 
contents of the pasteboard into the document in a specified data type. 
The submenu lists the possible data types, as discussed in "The Paste 
As Menu," later in this chapter. 

Attaches the Link menu, which contains commands for 
manipulating linked information. See "The Link Menu," later in 
this chapter. 

Deletes the current selection without copying it to the pasteboard 
(thus leaving the contents of the pasteboard intact). The Delete key 
has the same effect. 

Undoes the last editing change. This usually means all changes 
since the user last made a selection, including the selection of an 
insertion point. 

Attaches the Find menu, which contains commands related to the 
Find panel. See "The Find Menu," later in this chapter. 

Brings up the Spelling panel. 

Finds the next misspelled word without bringing up the Spelling 
panel. 

Makes the entire contents of the file the current selection. 

Applications that permit the user to edit text or graphics should support at least the Cut, 
Copy, Paste, and Select All commands. It's strongly recommended that you also implement 
the Undo command. 

Programming Note: The Edit Menu 

To get this menu, you can just drag it in from the Palettes window of Interface Builder. It's 
already hooked up to the Text object, which automatically provides all the menu's 
functionality except for Find, Paste As, Link, and Undo. 
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The Paste As Menu 

The Paste As menu is rarely needed because applications can take care of pasteboard data 
types without user intervention. However, sometimes it's useful for the user to be able to 
specify the format in which data is pasted. For example, the user of a page layout program 
might want to choose whether text is pasted as ASCII or Rich Text Format (RTF), or 
whether graphics are pasted as EPS or TIFF. 

This menu should include only the types appropriate for its application. As usual, the 
programmer should disable invalid menu commands. For example, when the pasteboard 
contains only text data, any graphics formats should be disabled. 

Checking Spelling 

The Spelling and Check Spelling commands in the Edit menu are intended to provide a 
uniform interface for checking spelling that in many ways parallels the interface for Find. 
(Find is discussed under "The Find Menu," below.) These commands for checking spelling 
are supported by the Application Kit's Text object; custom objects will need custom code 
for checking spelling. 

The Spelling command brings up the Spelling panel, which is described in Chapter 5. The 
Check Spelling command is equivalent to the button on the panel that searches for and 
selects the next misspelled word in the main window. It permits the user to find the next 
misspelled word without bringing up the panel. If the application can't find the next 
misspelled word until the user takes some action within the Spelling panel (for example, 
loads a dictionary), Check Spelling brings up the panel. (This is parallel behavior to Save 
bringing up a panel when the user must first supply a file name, or Find Next bringing up 
the Find panel if the user needs to enter a text string to search for.) 

If an application has spelling options that can't be accommodated in a panel, Spelling and 
Check Spelling should be replaced by a Spelling command that brings up a submenu. That 
menu might then have Spelling Panel and Check Spelling commands. 
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The Link Menu 

The Link menu provides a standard interface for receiving and supplying linked 
information. Linked information is copied information, such as a graphic image, that can 
be automatically updated when the original information is modified. See the User's Guide 
for more information on working with links. 

Command 

Paste and Link 

Paste Link Button 

Publish Selection 

Show Links 

Link Inspector 

Action 

If the last Copy operation was performed in an application that can 
supply linked information, this command pastes the contents of the 
pasteboard and links it to the original information. 

If the last Copy operation was performed in an application that can 
supply links, this command pastes a button <) that, when clicked, 
opens the document that contains the original information. Link 
buttons are discussed in Chapter 7, "Controls." 

Creates a link file. When the link file is dragged into documents 
that can receive linked information, the end result is as if a Paste 
and Link command had been done. This command places a 
panel on-screen that asks the user to type in a file name or cancel 
the command. 

Highlights or unhighlights all linked information in the current 
document. The name of this command must alternate between Show 
Links and Hide Links, depending on the state of the document. 

Brings up the Link Inspector panel, which is discussed in Chapter 5. 
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An application that can receive linked information (one that implements one or both of the 
Paste and Link and Paste Link Button commands) should also implement Show Links and 
Link Inspector. 

When the user chooses the Show Links command, the application should highlight all the 
, linked information in the main window, as shown in the following figure. In the window 
shown below, the picture at the lower left is the only visible linked information, so it's the 
only picture that's highlighted with a chain pattern. 

I . - ,.-' --- - ,--' -----. -_.'- --. --.-------- -- - - .--- -"" -- - --.- - "-, --- -- --- ,- .--- .-
1[iJ BP Logos.draw .- -/projects/Logo Studies ~ 
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Programming Note: Implementing Links 

The Application Kit supports links with its NXDataLinkManager and NXDataLink classes. 
See the NeXTSTEP General Reference (available through Digital Librarian) for detailed 
information on how to make your application receive and supply links, 



The Find Menu 

Applications that display large amounts of text are encouraged to include a Find menu like 
the one illustrated above. Other applications might also find this menu useful, but because 
it's designed most specifically for text, a variation of it might better meet their needs. 

Command 

Find Panel. .. 

Find Next 

Find Previous 

Enter Selection 

Action 

Brings up the Find panel, makes it the key window, and selects 
everything in the text field labeled Find so that the user can easily 
enter new text. If the panel is already on-screen, the command 
brings it to the front, makes it the key window, and selects the 
Find field. 

Searches forwards for the next occurrence of the string in the panel's 
Find field. 

Searches backwards for the previous occurrence of the string in the 
panel's Find field. 

Enters the current selection into the panel's Find field so that Find 
Next and Find Previous can search for it. 

Jump to Selection Scrolls to display the beginning of the current selection. 

Find Next and Find Previous begin searching at the current selection. If the search is 
successful, the text that's found is selected and becomes the starting point for the 
subsequent search. Neither command requires the Find panel to be on-screen. However, if 
the panel's Find field is empty, Find Next and Find Previous both bring up the Find panel, 
make it the key window, and select its Find field. This is exactly what the Find Panel 
command does. These other commands do it as a convenience to the user, who has 
indicated an intention to do a search. 

The Find panel is further described in Chapter 5. 
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The Format Menu 

Command 

Font 

Text 

Page Layout. .. 

Action 

Brings up the Font menu, which has commands to alter the font of 
the current selection. (See "The Font Menu," later in this chapter.) 

Attaches the Text menu, which lets the user choose the format of the 
selected blocks of text. (See "The Text Menu," later in this chapter.) 

Brings up the Page Layout panel, which lets users determine how 
documents are to be printed and displayed on the screen. 

The Format menu should hold the principal formatting commands needed by users of the 
application. For applications that deal mainly in numbers, they may be commands that 
format the text display of floating-point numbers or the graphical display of numeric data. 
For text processors, they may include the commands that would otherwise go into the Text 
menu, plus others. 

If an application promotes the Font command to the main menu and has no other commands 
to add to the Format menu, the Format menu would become little more than a container for 
the Text menu. In this circumstance, the commands that would otherwise go in the Text 
menu should be placed directly in the Format menu. A separate Text menu is needed only 
when there's reason to isolate these commands from other formatting commands or to 
shorten what would otherwise be an excessively long "Format menu. 

When commands from the Text menu are placed in the Format menu, they should 
follow the Page Layout command, so that the Copy Ruler and Paste Ruler commands 
end the menu. 
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The Font Menu 

Applications that support text entry and editing should provide a Font menu and Font panel. 
The Font panel is described in Chapter 5. It contains controls that let users set and preview 
fonts. The Font menu has a command to bring up the panel, and commands to make 
common adjustments to a font. 

Each command alters one aspect of the font, such as its size or style, while leaving other 
aspects intact. The Font menu and Font panel target currently selected text. The 
Preferences panel should be used to alter the default font. 

Command 

Font Panel... 

Bold 

Italic 

Action 

Brings up the Font panel. 

Makes the current selection bold, if it's not bold already, and makes 
it unbold if it is. The name of the command must alternate between 
Bold and Unbold depending on the selection. 

Makes the current selection italic or oblique, if it isn't already, and 
makes it unitalic if it is. The name of the command must alternate 
between Italic and Unitalic depending on the selection. 

( continued) 
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Command 

Underline 

Larger 

Smaller 

Heavier 

Lighter 

Superscript 

Subscript 

Unscript 

Copy Font 

Paste Font 

Action 

Underlines the current selection, if it isn't already underlined, and 
removes the underlining if it is. When the current selection is already 
underlined, the command name must change to Ununderline. 

Makes the current selection one point larger. 

Makes the current selection one point smaller. 

Uses a heavier typeface to display the current selection. 

Uses a lighter typeface to display the current selection. 

Moves the currently selected text up an appropriate amount for a 
superscript. Choosing the command again moves the text that 
much higher. 

Moves the currently selected text down an appropriate amount for 
a subscript. Choosing the command again moves the text that 
much lower. 

Returns the selected superscripted or subscripted text to the normal 
baseline of the text. 

Copies from the current selection all the text attributes listed in this 
menu, including font family, font size, bold, italic, underlining, 
superscript, and subscript. 

Alters the current selection so that it has all the font attributes 
previously copied with the Copy Font command. 

Programming Note: The Font Menu 

By dragging this menu in from Interface Builders Palettes window, you getthis menu and 
its functionality from the Text object with almost no additional work. Still, you should 
make sure that every command works, dims, and changes it name as it should. 



Note: If the current selection is an insertion point, all the commands in the Font menu 
affect the next set of characters inserted, rather than any existing text, unless the text area 
can contain only one font. If an area of text can have only one font, then the Font menu and 
panel change the font of all the text in the area. 

The only required commands in the Font menu are Font Panel, Copy Font, and Paste Font, 
although frequently used commands like Bold and Italic should almost always be present. 
Applications that are not text intensive may decide to omit some of the less frequently used 
commands, such as Heavier and Lighter. 

Each command leaves the other font attributes intact. For example, Bold will change 
11-point Times Roman to 11-point Times Bold and 24-point Courier Oblique to 24-point 
Courier Bold Oblique. 

If there's more than one font in the selection, Larger and Smaller change each to be one 
point larger or smaller than its current size. The other commands make only the change 
that's appropriate for the first character in the selection. For example, if the first character 
in a multifont selection is italic, the Unitalic command will remove the italic trait from all 
the text in the selection, but won't change any text that isn't italic. If the first character isn't 
italic, the same command (but now called Italic) will italicize the entire selection, but won't 
alter any text that's already italic. 

The Colors command, which brings up the Colors panel, often appears in the Font menu. 
However, it can appear elsewhere; each application should place the Colors command in a 
menu that indicates the kind of objects the Colors panel can affect. In Mail and Edit, colors 
can be applied only to characters (and not to their background), so the Colors command is 
in the Font menu. 
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The Text Menu 

The Text menu is a collection of formatting commands that affect text. All the Text menu 
commands are supported by the Application Kit's Text object. These commands can be 
isolated into a Text submenu, as shown here, or be included directly in the Format menu. 
If you have other formatting commands that are more important to your application, those 
commands, rather than these, should go in the Format menu. 

Command 

Align Left 

Center 

Align Right 

Justify 

Show Ruler 

Copy Ruler 

Paste Ruler 

Action 

Aligns the text at the left margin, leaving a ragged right margin. 

Centers the text between the left and right margins. 

Aligns the text at the right margin, leaving a ragged left margin. 

Aligns the text at both the left and right margins. 

Displays a ruler in the text area, if the ruler isn't currently visible. 
Otherwise, this command hides the ruler. The name must alternate 
between Show Ruler and Hide Ruler, depending on the state of the 
text area. The ruler is a scale containing controls that affect the 
format of a paragraph (such as margins and tabs). 

Copies the ruler settings in the first paragraph of the selected text. 

Alters the paragraphs containing the text selection to have the 
settings most recently copied with the Copy Ruler command. 

An application that has many other text-related commands, such as a word processor, can 
arrange all its text-formatting commands within the Format menu, as best fits its needs. 
(See also the discussion of the Format menu earlier.) However, for consistency, all 
applications should, as far as possible, retain the command names shown above for the Text 
menu, no matter how the commands are arranged. 
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The Windows Menu 

The Windows menu contains commands affecting the windows that belong to the 
application. You can replace this menu with one more suitable for your application. For 
example, an application that has multiple windows per document might have its own tools 
to organize the windows. 

Command Action 

Arrange in Front Stacks and offsets all the application's document windows 
(those that can become the main window and are created using 
Open and New commands) at the front of the screen. While this 
command is recommended, it isn't mandatory. 

Miniaturize Window Miniaturizes the key window (if it has a miniaturize button). 
The affected window need not be a document window. 

Close Window Closes the key window (if it has a close button). If the window 
is the last one (or only one) open displaying a document, it also 
closes the document, just as the Close command would. 
(See "The Document Menu," earlier, for a description of the 
Close command.) 

The commands in this menu bring windows to the front of the screen and, in the case of the 
last two commands, remove them. Other kinds of commands, even if they affect windows 
in some way, should be located elsewhere in the menu hierarchy. 

You can replace Arrange in Front with an Arrange command that brings up a panel or menu 
giving the user more choices concerning which windows to arrange and how they should 
be tiled or stacked. 

Programming Note: The Windows Menu 

This menu and all of its functionality are provided for you. All you have to do is drag the 
Windows command into your main menu from the Palettes window of Interface Builder. 
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The commands inserted below Arrange in Front list document windows. Each command 
brings one window to the front and, if possible, makes it the key window. The Application 
Kit creates this list and dynamically adds a command for each document window when it's 
opened. An example of these dynamically created commands is below. Because the 
Application Kit creates the command names from the title bar of each window, improperly 
titled windows can lead to the Windows menu becoming confusing or too wide. Window 
titles are discussed in "Choosing a Title" in Chapter 4. 

r Arrange in Front 
If::'· Ap·oem..:..· . .:JinProgress 
r ..... .... '.' 
IX A Poem -..., 

.. ... 

IMiniaturize Window m 

w 

The Services Menu 

Services 

! Define in Webster 
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!"Librarian t-

rMaii ~~. 
~..... .... ..' .... .. " ....... " ... . 
; Open in Workspace 
iProJed ., .. t:. 
ITerrrlit1al' '.. . ., .... , .. i; 

This required menu contains commands that invoke services provided by the system or by 
other applications. All the commands in the menu are placed there by the Application Kit 
from information furnished by service providers (so there's no need to specify where 
commands should be added). 

130 Chapter 6: Menus 



Providing Services 

Applications can specify how commands that request their services should be worded. The 
following guidelines apply: 

• Each command should begin with a verb and should name the application that will 
respond to the request. If the name of the application can be interpreted as a verb, it can 
be the first word of a command phrase (for example, Chart Selection for an application 
named Chart). Otherwise, the verb that begins the command should be followed by a 
preposition and the name of the responding application (Open from Workspace, 
Define in Webster). 

• If an application responds to more than one service request, it can arrange the commands 
in a submenu under the application's name. Commands in the submenu don't have to 
name the application, but should, like all other commands, begin with a verb. 

However, if the application name is commonly interpreted as a verb, the submenu 
commands can consist of words that would meaningfully follow the application name in 
a phrase, much as the commands in the Paste As menu. For example: 

Service requests conditionally activate the other application, but only if user input might be 
required. For example, Digital Webster is likely to require the user to scroll the display, but 
the Workspace Manager doesn't need the user's help to get a file opened. The application 
that opens the file will become active, but the Workspace Manager won't. 

Programming Note: The Services Menu 

To take advantage of services provided by other applications, you should first drag the 
Services menu from the Palettes window of Interface Builder. Then, if you use the Text 
object in your application, your application automatically gets many services. Your 
application can get more kinds of services if you write a few lines of code. 

To put its services into other applications, your application advertises its services in a 
section of its executable file or in its file package. (File packages are special folders that 
look and behave like files.) These services are automatically included in the menus of any 
applications that can accept them. 
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Adding a Tools Menu 

Since it's easiest for users to find a command if it's arranged in a submenu with other 
functionally related commands, commands that bring up panels and special, nondocument 
windows should be located throughout the menu hierarchy as appropriate. For example, 
the Font Panel command is in the Font menu, the Open command is in the Document menu, 
and Page Layout is in the Format menu. 

However, if a window or panel is an independent tool that encapsulates a functional domain 
all its own, it may be difficult to group it with other commands. Examples are the palettes 
in a graphics program, the Inspector in Interface Builder, and the Console in the Workspace 
Manager. If your application has two or more such commands, you should consider 
collecting them together in a Tools menu. An example from the Workspace Manager is 
illustrated below. 

However, the Tools menu should not be considered a default location for commands that 
bring up windows or panels. If a window or panel isn't perceived to be a tool, its command 
should go elsewhere. If a command can be functionally grouped, it should be. 
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7! Controls 

Controls are graphical objects that users manipulate with the keyboard and mouse to give 
instructions to an application. They're patterned after familiar control devices from 
everyday life-switches, knobs, forms, gauges, and the like-and perform analogous 
functions. Like the dials and levers on a machine, graphical control objects let the user 
"operate" an application. 

Every control responds visually to direct manipulation by the user-a dial turns, a button 
pushes in or highlights, the knob of a slider slides. Controls go beyond this direct response, 
however, to cause the application to do something. They, in effect, translate the user's direct 
manipulation into an instruction for the application. A button sets a state or initiates a 
program action, a slider sets a value, and so on. 

Which keyboard and mouse actions a control responds to and how it reacts visually are part 
of the definition of the control; they're discussed in this chapter. What the control causes 
an application to do is part of the definition of the application; it depends solely on how the 
application uses the control. In this respect, graphical controls are no different from control 
devices in the real world. For example, identical mass-produced switches can be installed 
on a variety of different machines. The manufacturer of the switch provides it with a user 
interface; the installer gives it specific meaning for a specific machine. 
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The NeXTSTEP user interface has several standard controls: 

• Buttons 
• Menu commands 
• Text fields 
• Sliders 
• Color wells 
• Scrollers 
• Browsers and selection lists 

Because they're widely used, each of these controls is described in some detail in its own 
section. Menu commands were described in Chapter 6, "Menus." The other controls are 
described in the sections below. 

You can also design your own controls-the Application Kit makes this relatively 
easy-but they should adhere to these basic design principles: 

• Every control must provide immediate feedback to let the user know that an action has 
"taken." Just as users can look at a dial on a stove to see whether it has been turned, a 
graphical control must alter its appearance in response to user actions. It shouldn't 
depend on a reaction elsewhere in the application to give the user feedback. 

• Every control should have a distinctive appearance and behavior. Don't design controls 
that look so similar to the canonical controls that users will confuse one with the other. 

• The behavior of a control should be apparent from its appearance. After a bit of 
familiarity with NeXTSTEP, users should be able to easily recognize a control object 
and know almost instinctively how to operate it. 
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Buttons 

Buttons are the primary controls for setting a state or initiating an application action. 
They're used for the controls in title bars (the miniaturize and close buttons), for Cancel and 
the other choices that dismiss attention panels, and in most other situations where a basic 
control device is called for. 

Buttons can assume a variety of different shapes and sizes, some of them standard. The 
figure below shows the standard types of buttons. 
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How Buttons Work 

<) 

a link button 

a switch 

The Application Kit provides two basic kinds of buttons: one-state (or action) buttons and 
two-state buttons. Action buttons perform a single task, such as scrolling a document 
forward or starting a search. A two-state button sets a single characteristic on or off, such 
as whether to restrict a search to whole words. Standard two-state buttons include switches 
and radio buttons. Some buttons also bring up lists, as described in the following section. 
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All buttons respond to a click. Some also respond to being pressed. A button that responds 
to being pressed sends an instruction to the application as soon as the user pushes the mouse 
button down. Typically, it repeats the instruction at regular intervals-as long as the mouse 
button is held down and the cursor is kept over the button on-screen-for a continuous, 
iterative action. Users can drag away from the button and back again to stop and restart the 
action. A button that responds only to being clicked sends its instruction to the application 
when the user releases the mouse button, provided the cursor is over the button on-screen. 

Whether it responds to being clicked or to being pressed, a button changes its appearance 
as soon as the mouse button goes down. It retains its altered appearance while it's under 
the cursor and the mouse button remains down. When the user releases the mouse button, 
the button on-screen keeps its altered appearance long enough for its instruction to be 
carried out. Usually this is momentary (though it need not be), so users generally notice 
the button changing as soon as the click is over. 

Buttons that Bring Up Lists 

The Application Kit has support for two kinds of button-list combinations: pop-up lists and 
pull-down lists. A pop-up or pull-down list is a window that comes to the screen when the 
user presses a button. The user can drag through the list to choose an option or action. The 
list stays on-screen only as long as the user keeps the mouse button down. Although pop-up 
lists and pull-down lists look similar, they have very different roles in the user interface. 

Pop-Up Lists 

Pop-up lists are used in lieu of a series of radio buttons. They save screen space and prevent 
overcrowding in panels. Each list is controlled by a button that can be recognized by a 
special symbollQ, as shown below. The label on the button that precedes the symbol 
indicates the .current selection from the list. When the user makes a new selection, the 
button label changes. 

Inlnc~e~ 
L ;iCentimeiers d 

Pofriis 
Picas 

Pressing the button pops the list up so that the item matching the button label appears on 
top of the button. The list remains up only while the user holds the mouse button down. 
When the user releases the mouse button after dragging to a different item in the list, the 
label on the button changes to that item. 
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Pull-Down Lists 

Pull-down lists are similar to pop-up lists, but they're used to perform actions, rather than 
to set a state. In this respect, pull-down lists are somewhat like menus. 

Visually, pull-down lists differ from pop-up lists in that the controlling button's label never 
changes, and it's marked by a different symbol v. 

Action ... v rActi~I~;-----~ 

Send Back I Send Back 

Discard I Discard ... 

, Keep k I Keep' k 

Implementing Buttons 

When implementing any kind of button, you must make the following decisions: 

• The end result of clicking the button 
• The image or label (or both) on the button 
• How the button's appearance changes during a click 

Of course, before using a button, you should be sure that it's the best control for the job. 
"Choosing the Appropriate Control," at the end of this chapter, discusses which controls 
can be used for which types of functionality. 

Choosing the Button's Result 

A one-state (action) button shouldn't change the action it performs. Although it's 
sometimes tempting to alter the action with the application's state-to switch between 
Erase and Restore, for example-it's best to provide a different button for each action and 
disable those that aren't operable. This lets the user safely click in the accustomed place 
without having to consider which state the application is in. However, it's acceptable for 
buttons that perform time-consuming actions to have a stop state, as described in 
"Implementing Stop Buttons," later in this chapter. 

One-state buttons are generally labeled with a verb or verb phrase (such as Find), but 
occasionally they have only a graphic image (such as the arrowhead in a scroll bar button). 
Labeling conventions are discussed in "Choosing the Button's Image or Label," below. 
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Two-state buttons should never perfonn actions, although the characteristic they affect 
might result in some visible change. For example, an inspector for a graph might have a set 
of radio buttons that control the graph's type (line, bar, and so on). Clicking one of the 
buttons resets the graph's type, which in tum results in the graph being redrawn. However, 
it wouldn't be acceptable for the radio button to, for example, create a second graph of the 
new type. 

Ideally, as soon as the user clicks a two-state button, the visible consequences (if any) 
should be shown immediately. However, that's not always practical, as when changing the 
characteristic takes a long time or isn't easy to reverse. For example, if changing the type 
of a graph takes a long time, then the application might wait for the user to click a Redraw 
Graph button before redrawing the graph. 

However, whether or not a two-state button's associated characteristic changes 
immediately, the button's appearance always changes immediately, as described in 
"Changing the Button's Appearance during a Click," later in this chapter. 

Buttons with more than two states aren't recommended: It's very difficult to convey their 
result to the user. 

Choosing the Button's Image or Label 

A button's label should say, in a succinct shorthand, what action it causes the application to 
take. Even when a button purports to label a state (such as AM or PM), users are apt to 
think of it not as the current state, but as the state that will be set if the button is clicked. In 
other words, they're liable to interpret it as an action. An On button, for example, is more 
likely to be interpreted to mean "Press this to tum something on" than "This is now on." 

It's best, therefore, to use images and highlighting to show the current state, and reserve the 
button's label as a brief statement of what the button does. Buttons that do label a state, 
such as a button that switches between AM and PM, should be used only where what they 
label is clearly visible. For example, AMIPM buttons can be used alongside a digital 
representation of the time, but they can't stand alone. These and other two-state buttons are 
shown in the figure in the following section. 

Note: Make sure that the button clearly looks like either an action button or a two-state 
button. It's confusing to the user to see a two-state button that doesn't clearly have two 
states, or an action button that doesn't look like it perfonns an action. 

You should always dim the label of a button (using gray text) whenever pushing the button 
will have no effect. A dimmed button is completely disabled-pushing it shouldn't cause 
it to highlight, push in, or change in any other way. 
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Button labels should be capitalized like menu commands: The first and last words begin 
with uppercase letters and the words between are capitalized as they would be in a title. 
Like menu commands, buttons that always bring up a panel (unless it's a warning panel) 
should have three dots ( ... ) at the end of the label. 

When an action button can be chosen using the Return key, the button should contain the 
Return symbol to the right of its label, as shown below at the left. However, when pressing 
Return won't choose the button-for example, when the button's window isn't the key 
window-the Return symbol should disappear from the button (as shown at the right, 
below). Removing the Return symbol helps avoid user confusion over whether pressing 
Return will work. 

1--- ---- -------------

I~ Nonexistent path Nonexistent path 

The path /me/Mise does not exist, create it? The path /me/Mise does not exist, create it? 

,; 'Cancel I: Cr~ate ~ I Cancel 1:[· Create " I 

Programming Note: Making the Return Symbol Disappear 

All Application Kit panels automatically remove the Return symbol when the panel isn't 
the key window. Attention panels created with NXRunAlertPanel() and its related 
functions also remove the Return symbol automatically. 

For other panels, you need to explicitly remove and add the Return symbol for the 
appropriate button. You can do so in your implementation of the windowDidResignKey: 
and windowDid8ecomeKey: delegate methods of the Window class. 
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Changing the Button's Appearance during a Click 

A button's appearance during a click (or while it's pressed) should change in one of the 
following ways: 

• It can highlight. 
• It can both highlight and appear to be pushed in. 
• It can change the image it displays. 

Note: Highlighting can be done either automatically by the Application Kit or by changing 
the image to a custom, "highlighted" image. 

Buttons normally both push in and highlight. However, for aesthetic reasons, buttons that 
are right next to each other (such as scroll buttons and graphical radio buttons) shouldn't 
push in. This is because buttons that have no space around their bezeled edges look less 
three-dimensional than normal. 

Note: Although it's possible to have a button only push in (without highlighting), this isn't 
recommended because it's hard to see. 

The recommended changes for action (one-state) buttons are illustrated in the following 
figure. The scroll button in the bottom row doesn't push in, since it's very small and is right 
up against another scroll button. 

before 
clicking 

during 
click 

after 
clicking 

The possibilities for two-state buttons are illustrated in the following figure. 

before 
clicking 
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Note: In the figure showing two-state buttons, the button in the bottom row is a graphical 
radio button. It doesn't push in because it's right next to the other radio buttons in its group 
(although they aren't shown in this figure). 

The figure of two-state buttons also illustrates some of the principles that determine how a 
button looks during a click: 

• A button must change its appearance during a click, as soon as the mouse button 
goes down. 

• The appearance of a button during a click should reflect what's about to happen. Buttons 
that display a state should reflect the new state both during and after the click. 

Implementing Pop-Up and Pull-Down Lists 

You must provide a title for each pop-up list. Usually this is done by putting a titled box 
around the pop-up list's button. The figure below shows a typical example, using a box with 
the title Units. 

r ... ·!", .. ·.·:.·-...• ·.:·.·~' .. •.· •.. -~.u.· .... '~.· .. it .. S -.. ··~ •. ·.~.'.··· .. ·.··.··~l.~ .. , .• j .. 
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Because the label on a pull-down list's button doesn't change, pull-down lists don't need a 
titled box around them. 

When using a pop-up or pull-down list, be careful that the open list doesn't blend in with 
the objects near it. If an item in the list pops up next to a label, for example, users might 
interpret them in combination. Take care, too, that the open list doesn't obscure any objects 
that help users understand its content. 

Programming Note: Lists that Bring Up Attention Panels 

When an item in a pop-up or pull-down list opens an attention panel, the list by default 
stays up until the panel is dismissed. Because lists are in a higher window tier than 
attention panels, they can obscure attention panels. To avoid this, you should dismiss the 
list before bringing up the attention panel. One way of doing this is to have the list item 
call the perform:with:afterDelay:canceIPrevious: method to schedule the execution of a 
method 1 millisecond in the future. This method should then bring up the attention panel. 
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Implementing Link Buttons 

Link buttons are different from most buttons because they're usually created by the user, 
instead of built into the application. Because link buttons often appear in custom content 
areas-areas that can be unique to each application that implements link buttons-link 
buttons require a little more support from the application than do other kinds of buttons. 
When implementing link buttons, you should be careful that they act in the following way: 

• Clicking a link button highlights it briefly and brings up the document containing 
the information that the link refers to. An unmodified click should never select the 
link button. 

• Shift-clicking a link button selects it. 

• If the user presses the mouse button while the cursor is over the link button and then 
drags away without releasing the mouse button, the button should lose its highlight. 
However, if the user then drags back over the link button while still keeping the mouse 
button down, the link button should become highlighted again. 

Implementing Stop Buttons 

If an action might take a while, then the user should be able to cancel it by holding the 
Command key while pressing the period (.) key (as described in Chapter 3, "User Actions: 
The Keyboard and Mouse"). In addition, sometimes it's convenient for buttons that 
perform a time-consuming action to have a stop state, to make it more obvious to users that 
they can interrupt the action. 

If you implement a button with a stop state, the button's appearance should change as 
shown below. 

before 
clicking 

during 
first click 

after 
first click 

during 
second click 

(if any) 

after action 
is finished 

or canceled 

The button's action should be started when the user completes the first click (by releasing 
the mouse button). Similarly, the button's action should be stopped when the user finishes 
clicking the stop button. 
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Text Fields 

A text field is a slot where the user can type in a single line of data-such as a file name, a 
part number, or an address. The text is editable and selectable. The data is entered only 
when the user types Return or clicks a button that's associated with the field. If the user 
enters more text than will fit in the field, the entry automatically scrolls so that the insertion 
point stays visible. 

A text field should have a white background and be surrounded by a bezeled border that 
makes it appear inset from the surface of the screen. When the text field is temporarily 
disabled, the text becomes gray (just like the label of a button), but the background color 
doesn't change. 

If a text field is not usually edited or selected but can be-as is, for example, the name 
associated with a file icon in the Workspace Manager File Viewer-the text should have a 
gray background with no bezeled border. When the user selects the text, the text field's 
background should turn white, and the selected text's background should be light gray. 

Text fields can be titled and arranged in groups to produce an on-screen form, such as the 
one illustrated below. 
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When there's more than one text field in a window, the Tab key can move the selection-the 
point where typing will appear-from one field to another: 

Tab 

Shift-Tab 

Moves from one text field to the next one in the series. For example, in 
the form illustrated above, Tab would cause the current selection to jump 
from the Name field to the Street field to the City field, and so on. 

Moves from one text field to the previous one in the series. 

When the user presses the Return key after typing in a text field, the field usually makes 
something happen. Data might be entered and processed, a search might begin for text that 
matches the string in the field, or a document might be saved to a file name the user typed. 
Exactly what happens is up to the application. 

Text Fields 143 



To let users know what to expect, it's recommended that you include a button in the display to 
act as the equivalent of Return. The button's label is an explicit reminder of what Return will 
do. From the user's point of view, Return is simply a shortcut for the action of the button. 

The Print panel below has an example of using a button for the Return key's action. The 
user can start printing the document either by pressing the Print button or by pressing 
Return while editing any of the three text fields. If the user presses Return, the Print button 
pushes in and highlights as if it were pressed. 

Name: pubsnp 
Note: Publications 
Progress: 

::g';1 PGraffs_Printer NeXT 400 dpi Level II Printer 

~ PostMan NeXT 400 dpi Laser Printer 

. 11 pubsnp NeXT 400 dpi Laser Printer 

!I~~~~XSP:i~t:r' N:XT 400 dpi Levell! Printe~ 

r~~'r '1"'" ""'.'. ..Pages' .. ' ..... " "':"""'1 
I~: ()AI! C' FromO; TOC:]:· 
. . .. . .. ... .. ·1'~.ss~tte~W';~11140~~::,O'~liO~'tTJ 
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For the user's convenience, if the action associated with Return is repeatable, Return may 
select all the text in the same field so the user can easily replace it. 

When a text field is part of a form, Return might not perform any particular action of its 
own. Instead, it will do just what Tab does-move the selection to the next field. Action 
on a button or other control is required to enter data typed into the form. 

Generally, text fields accept unrestricted data, but sometimes an entry won't be acceptable 
if it's the wrong data type-if, for example, the user types in a floating-point number when 
an integer is called for. Typical examples of restricted data include the following: 

• Unsigned or signed integers 
• Unsigned or signed floating-point numbers 
• Dates 
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Sliders 

If the user's entry isn't acceptable, all of the text in the field should be selected and 
highlighted. The user can make any necessary corrections and try again. 

A slider is a device that sets a value. As illustrated below, it consists of a vertical or 
horizontal bar and a knob that moves on the bar. 

bar 

knob 

The position of the knob in the slider indicates its current value. Users can move the knob, 
and thus alter the value, by positioning the cursor anywhere over the bar (even the part of 
the bar that's covered by the knob) and pressing the mouse button. The knob immediately 
jumps to the location of the cursor. The user can release the mouse button to fix the knob 
in its new location, or begin dragging the knob along the bar. 

A slider can set values on a continuous scale (between some maximum and minimum) or 
values at discrete intervals. If the latter, the knob jumps to the position of the nearest 
permitted value when the user releases the mouse button. When the user presses the 
Alternate key and drags the slider's knob, the slider should set values at precise, discrete 
increments that are smaller than the usual increment for unmodified dragging. 

The user should always be able to detect a direct effect of manipulating the slider's 
knob-this is usually done in a text field or label next to the slider (as shown in the 
following figure). 

Programming Note: Implementing Alternate-Dragging for Sliders 

Your application should specify the increment amount to be used for Alternate-dragging. 
Otherwise, Alternate-dragging has the same effect as unmodified dragging. 
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Color Wells 

Color wells are controls that let the user choose a color. They're powerful but inherently 
indirect, so you should use them only when necessary. Color wells let the user choose many 
colors from the Colors panel simultaneously, one for each possible aspect of an object's 
color. For example, in the figure above, an object can have two colors-its fill color and 
the color of its outline. 

Note: The Colors panel is an Application Kit panel discussed in Chapter 5, "Panels." The 
Colors panel is brought up by the Colors command; it also appears whenever the user 
selects a color well's border. 

One alternative to using a color well, when the group of acceptable colors is small, is to use 
graphical radio buttons (as pictured in the "Buttons" section earlier in this chapter). 
Another alternative, when a wide range of colors is needed, is to use the Colors panel alone. 
The user can change an object's color by selecting it and then choosing the new color in the 
Colors panel. You can also use a new, customized control if it's more appropriate in 
appearance and functionality than a color well. 

To choose a color for a color well, the user drags a color either from the Colors panel or 
from another color well. Another way to set the color is to select the border of the color 
well. The well's color then changes every time a new color is chosen in the Colors panel. 
Because the user might not realize a border is selected, this scheme can be confusing. You 
should be careful to deselect the border whenever the user isn't likely to want to change the 
color. For example, you should make sure'that color wells are deselected when their 
window is miniaturized. 

When an object is selected, each visible color well should change its color to reflect the 
object's associated color. For example, if a white box with a red border is selected, then the 
Fill well shown in the previous figure should contain white, and the Line well should 
contain red. Once the user changes the color in a well, that change should be reflected in 
the selected object. For example, dragging a swatch of green from the Colors panel into the 
Line well should immediately make the outline of the selected box green. 

Whether or not a color well's border is selected should have no effect on whether the well 
affects the object that's currently selected. 
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Scrollers 

Scrollers are used to control what's displayed within a window or panel, or within a 
rectangular subsection of a window or panel. When the material to be displayed is larger 
than the opening available to display it, the user must scroll unseen portions into the 
opening in order to view them. The figure below shows, diagrammatically, a scrollable 
document, the area available to view it, and the scrollers that can move the opening around 
on the surface of the document. 
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How Scrollers Work 

As illustrated below, a scroller has just three parts, a bar, a knob, and an optional set of 
scroll buttons. This figure shows a vertical scroller, which scrolls information up and down. 
A horizontal scroller scrolls from side to side. 

If the material to be displayed is provided with scrollers, but happens, perhaps temporarily, 
to fit within the opening, then the knob and scroll buttons disappear, so the scroller looks 
like a plain gray strip. The strip indicates that the material will be scrollable, should it grow 
larger than the opening. 

The Knob and Bar 

The bar of a scroller represents the entire scrollable area. The knob represents the part of 
the area that's visible. The placement of the knob in the bar shows which part is currently 
visible in the opening. On a vertical scroIler, the height of the knob relative to the height 
of the bar indicates how much of the material, from top to bottom, is visible. On a 
horizontal scroIler, the width of the knob indicates how much of the material is visible from 
side to side. The knob shrinks as the user adds to the material, and grows as material is 
deleted. However, the knob never shrinks to be smaller than a square. 

Users scroll the display by moving the knob in the bar. The knob can be moved in 
four ways: 

• By dragging it to a new location. The display is adjusted as the knob moves. 

• By clicking in the bar (outside the knob). The knob jumps to the location of the click, 
and the display is adjusted accordingly. If the user doesn't immediately release the 
mouse button after pressing it, the knob can be dragged to a new location .. This permits 
users, in a single mouse action, to select the general part of a document they want to view 
(by clicking in the bar) and then to adjust the display (by dragging the knob). 
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• By clicking or pressing the scroll buttons. The arrows on the scroll buttons point in the 
direction the knob will move. 

• By extending a selection outside the opening where it's displayed. This automatically 
scrolls unseen portions of the selection into view. 

The Scroll Buttons 

The scroll buttons permit more precise scrolling than direct manipulation of the knob. 
When clicked, a vertical scroll button scrolls a single line of text. When pressed, it 
repeatedly scrolls one line after another. Horizontal scroll buttons work in a similar way, 
scrolling a small fixed amount in a horizontal direction. 

The two scroll buttons on the same scroller form a related pair. When the user drags from 
one to the other without releasing the mouse button, each button acts as if it had been 
pressed. It's not possible to slide from the scroll buttons on one scroller to those on the 
other scroller, however. 

When the Alternate key is held down, the scroll buttons scroll one viewful at a time. 
Generally, when scrolling down a document, the bottom line (or two) is redisplayed at the 
top of the opening each time the display changes. When scrolling toward the beginning of 
a document, the top line ( or two) is redisplayed at the bottom. This provides users with a 
bit of overlapping context and reassures them that nothing was skipped over when the 
display changed. 

Sometimes scroll buttons appear alone, without the rest of the scroller. Since the knob and 
bar aren't present to indicate when it's impossible to scroll further in one direction or the 
other, the arrow on a scroll button must be dimmed when the button won't work. 

Programming Note: Scrolling 

Using Interface Builder, it's easy to put scrollers around an area. The Application Kit 
handles all scrolling behavior, including Alternate-clicking to scroll a large amount and 
Alternate-dragging to scroll a tiny amount. All you might want to do is adjust the amount 
that a click scrolls (even for graphics, it should be a distance comparable to a single line 
of text) and optimize drawing performance so that scrolling is as fast as possible. 
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Automatic Scrolling 

When the user begins a selection in the visible part of a document then drags outside the 
opening, the document will scroll continuously to bring more of the selection into view, 
until the user releases the mouse button. The farther the user drags outside the opening, the 
greater each repeated change in the display. It's as if the application tries repeatedly to 
bring the point under the cursor into view. 

As the document scrolls, the scroller knob is adjusted to reflect the current position of 
the display. 

Fine-Tuning Mode 

If a document is large, small movements of the knob may correspond to sweeping changes 
in the display. This makes it difficult for users to adjust the display with precision when 
dragging the knob. 

To make fine adjustments possible even for large documents, scrollers have a fine-tuning 
mode. When the user holds down the Alternate key and drags the knob, the knob and 
display move only slightly in response to large movements of the mouse. In this mode, the 
knob moves in the direction it's dragged, but doesn't stay with the cursor. It continues to 
reflect the position of the document being displayed. 

Once the Alternate key is released, any subsequent dragging action will cause the knob to 
jump to the position of the cursor. 

Implementing Scrollers 

If the material to be displayed is taller than the opening available to view it, it should have 
a vertical scroller. If it's wider than the opening, it should have a horizontal scroller. 

Writing Note: The User's View of Scrolling 

By moving the knob in the bar, users metaphorically move an opening around on the 
surface of a document so that they can see the portions they desire. Visually, of course, 
it's the document that appears to move, not the opening. This means that the knob and 
the display move in opposite directions. To avoid confusion, the user interface and the 
application's documentation should concentrate on the metaphor of adjusting the portion 
of the document that's visible, rather than adjusting the document to make it visible. 
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The scroll buttons for both vertical and horizontal scrollers should occupy the lower left 
comer, where the two scrollers meet. Keeping all the scroll buttons in the same region 
makes it easy for users to move from one set to the other. 

Controls that determine how a scrollable document is viewed can be placed within the area 
normally occupied by the scrollers (beneath and to the left of the document). Other sorts 
of controls should not be placed within this area. 

The Apps Folder 

This folder, Apps, appears in your homefolder to mark the location where 
personal applications should be placed. 

When the Workspace Manager starts up, it surveys thefile system, searching for 
appli cati ons. It looks in the following pI aces, in the following order. 

1. The application dock 
2. TheApps folder in your home folder 
3. The/LocalApps folder 
4. ThelNextApps folder 
S. ThelNextDeveloper/Apps folder 
6. ThelNextAdmin folder 
7. ThelNextDeveloperlDenns folder 

" ...... ..t. &: 

Among the controls that can be placed in the scroller area are these: 

• An editable text field to display the current page number can be located to the far right 
of the horizontal scroller (as shown above). 

• A pop-up list that lets the user scale the display can be located in the area of the 
horizontal scroller (as shown above). 

• A pop-up list used to control the viewing mode for the display (for example, preview 
versus drawing mode in a graphics application) can be similarly situated to the zoom 
pop-up list in the area of the vertical scroller. 

• Page scroll buttons that scroll from page to page or by viewfuls can be grouped next to 
the line scroll buttons in the lower left comer where the vertical and horizontal scrollers 
meet. Since there is no Application Kit support for page scroll buttons, but there might 
be in the future, a precise arrangement is not currently specified. (Typical page scroll 
buttons are shown above.) 
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Browsers and Selection Lists 

. 
selection list 

. 
browser 

Browsers and selection lists are similar-they both let the user select one or more names in 
a list. A browser shows text data that's organized in a hierarchy, such as: 

• Files and folders 
• Cities, counties, and states 
• The managerial structure of a company 

Selection lists look something like a single-level browser. They usually have scrollers, but 
they don't have to. 

See "Selection" in Chapter 3 for information on how users should select items in a browser 
or scrolling list. In addition to selecting by clicking, a browser or selection list may have 
an associated text field, which lets the user select by typing. The Save panel, for example, 
has a text field that helps the user select files in the panel's browser. 

If double-clicking an item within a selection list or browser does anything, it should 
perform the same action as pressing the Return key (that is, the same action as the button 
marked with the Return symbol). 
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Choosing the Appropriate Conto-oD 

For some situations, it's clear what control is appropriate: 

• Scrollers are used only when material is displayed in an area that might be too small. 

• Sliders are used when there's a need to graphically set a value that's in a bounded range 
(of colors, numbers, or sound levels, for example). 

• Text fields are used whenever it's impossible or impractical to provide a list of all 
possible values. 

• Color wells are used only with the Colors panel, and only where complex color 
characteristics are needed. 

• Browsers are used only for data that's organized in a hierarchy. 

Buttons and selection lists are flexible, though. They can be used in many ways. The 
following sections describe how to decide which type of button to use, and when to use a 
selection list. 

ControDs that Start Actions 

Actions should usually be started by either a menu command or a button. If necessary, you 
can even duplicate a menu command in a button. Even though text fields can start actions 
as the result of pressing Return, they should always have a button nearby that appears to be 
clicked when Return is pressed. 

Sometimes an action is relatively unimportant, and having a button for it takes up too much 
screen space. If the action isn't appropriate for a menu command for some reason, then 
another choice is to make it an item in a pull-down list. 

The following figure shows how the same action (printing) might appear as a menu 
command, button, and pull-down list item. (It normally appears as a menu command.) 

Windows r-· 

Print... p 

Services reo 

Options ~ v 
" . '--:--
Print... 

• Mail... 
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Controls that Show State 

Pop-up lists, selection lists, and two-state buttons are used to show state. (Menu commands 
should never be used to show state.) Sometimes a single control shows the state of a single 
option. Often, though, options are grouped. Such a group should have either a 
one-of-many relationship, where exactly one option is always selected, or an unrestricted 
relationship, where any number of options (or none at all) might be selected. 

Note: A third relationship is currently possible only in selection lists: a relationship in 
which either no choice or one choice can be selected. 

Controls that show state should be used strictly to show and set state, not to initiate actions. 
For example, although double-clicking an item in a selection list might cause an action to 
happen, the double-click is really a shortcut for selecting the item and then clicking a 
button. If setting state has visible consequences, such as causing the format of a document 
to change, then the consequences should merely be immediate feedback that the state has 
changed, and not a full action such as creating another document with the new format. 

Displaying a Single Option 

Often options are grouped together. Sometimes, however, a single option stands alone. In 
this case, a switch is the preferred control. Another possibility is a graphical two-state 
button, as long as it's very clear that the button has two states. 

Use Voice Alerts 

Displaying a Group with an Unrestricted Relationship 

To show a group of choices with an unrestricted relationship, as opposed to a one-of-many 
relationship, you should use one of the following: 

• A group of switches 
• A group of graphical two-state buttons that don't look like graphical radio buttons 
• A selection list 

switches 
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Switches and graphical two-state buttons are preferred, since selection lists are less 
attractive and don't give clues as to how many selections can be made at once. (If you use 
two-state buttons, be careful that they don't look like graphical radio buttons.) When space 
is tight or the list of choices can grow or shrink, a selection list might be more appropriate. 

Displaying a Group with a One-of-Many Relationship 

Several kinds of controls can be used to show a one-of-many relationship-that is, to let the 
user choose one and only one setting out of a list of possible choices: 

• A group of radio buttons (standard or graphical) 
• A pop-up list 
• A selection list 

The figure below shows these controls as if they were being used to set the background 
color of a text field. Because this use is inherently graphical and there are only a few valid 
choices, graphical radio buttons are the best choice, followed by standard radio buttons. A 
pop-up list is marginally acceptable for this use, and a selection list is the least appropriate 
choice. 

r,-['C B~kQ~~~!~,~;~,l r!:"-c'~,B,~,ac,,,7 .qJ;;;, ~~d-~,',',l, r["'-"~~~~,-'~j~~~~d, ~J-l 
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a selection list 

In general, you should use radio buttons (standard or graphical) for one-of-many 
relationships unless there's a reason to use another type of control. If radio buttons aren't 
appropriate, then usually a pop-up list is appropriate. A selection list is the last choice, 
since it isn't as obvious to the user that exactly one item must be selected at all times. 

The following considerations might help you decide which control to use: 

• If the control will be used frequently, consider using radio buttons (standard or 
graphical), since they're easier to operate and more accessible to the user. 

• If text doesn't adequately describe the choices, consider using a group of graphical radio 
buttons. 

• If space is limited or the window or panel looks too complex, consider using a 
pop-up list. 
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• If the list of choices can grow or shrink, consider using a pop-up list or a selection list. 

• If the list of choices can grow larger than the screen, use a selection list with a scroller. 

• If the user needs to see more than one of the choices on-screen to understand them, avoid 
using a pop-up list. 

• If the control will usually appear at the edge of the screen, you might want to avoid a 
pop-up list. The reason: A pop-up list usually pops up so that the current selection is 
under the cursor. But if the list is long and near the edge of the screen, it shifts so that 
the entire list can appear on-screen, which may change the selection under the cursor. 
Users might therefore unwittingly make a new selection while intending only to see 
what's in the list. When considering a pop-up list, think about whether it's important to 
avoid this behavior. 

• If many ordinary, text-based buttons are in the panel, a pop-up list might fit in better 
graphically. 
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The I nterface to the File System 

One of the goals of the NeXTSTEP user interface is to provide a simple, graphical interface 
to the UNIX operating system. This is largely the responsibility of the Workspace 
Manager, the application that's brought to the screen after the user logs in. More 
specifically, the Workspace Manager provides a graphical interface to the file system. It's 
a substitute for a UNIX command interpreter (or shell) that locates files, displays folder 
contents, associates files with applications and icons, starts up applications, and keeps track 
of the user's home folder and working environment. It lets users manage files by 
manipulating their iconic representations. 

For command-line interaction with the operating system, users can put up a window that 
emulates a VT-I 00 terminal and runs a standard shell. This window is provided by the 
Terminal application, which can be started up from the Workspace Manager. 

Terminal is documented in the NeXTSTEP Development Tools and Techniques manual. 
The Workspace Manager is documented in the User's Guide. 
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How the File System Is Organized 

The NeXTSTEP file system is arranged very much like a traditional UNIX file system. 
However, by default, when users view the file system in the Workspace Manager, they 
won't see many of the traditional UNIX folders. Instead, they'll see only a small number 
of folders that organize the tools and information they most need. Under the root (f) folder, 
they'll find the following folders: 

LocalAdmin 
LocalApps 
LocalDeveloper 
LocalLibrary 
me 
Net 
NextAdmin 
NextApps 
NextDeveloper 
N extLibrary 
user 

Home Folders 

In the list above, the folder labeled user stands for the user's home folder. The hom~ folders 
of other users may also be visible. As is traditional, home folders bear the name of the 
user-the name that the user logs in under. By default, the user's name is me, and the home 
folder is fme. 

If a machine is connected to a file server over a network, users' home folders are likely to 
be located somewhere on the file server. The figure above simply illustrates the default 
location for a home folder and where it would be located if it were on the startup disk. 
Home folders on remote machines are accessed through the Net folder described below. 

When typing in a file name, users can specify their home folder as ..... For example, .... f Apps 
refers to the Apps folder that's in the home folder of the current user. 
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NeXT Fo~derrs 

Four of the top-level folders begin with a "Next" prefix-NextApps, NextAdmin, 
NextDeveloper, and NextLibrary. They contain documents, resources, and applications 
that are bundled with the computer. 

The NextApps folder contains supported applications for NeXTSTEP users. In it are 
general-interest applications like Edit, Preferences, Mail, and PrintManager. 

The NextAdmin folder also contains supported applications, but ones that will be used 
mainly by system administrators and network managers. They're not for general users like 
those in NextApps. 

The main purpose of the NextDeveloper folder is to provide applications and files that are 
necessary for developing NeXTSTEP applications. Some of the folders that can appear in 
NextDeveloper include: 

Apps 

Demos 

Examples 

Holds applications used by developers. This folder might not exist on 
all systems. Debuggers, profiling tools, language-specific editors, and 
other window-based programming tools belong here. Like all other 
applications in the four "Next" folders, these applications can be run 
from the Workspace Manager. Command-line debuggers and profiling 
tools are in standard UNIX folders such as Ibin and lusrlbin. 

Contains programs that demonstrate the capabilities of NeXTSTEP. 
These aren't full applications and aren't supported by NeXT. 
However, they include games and utilities that users, not just 
developers, might find interesting. 

Contains source code for example programs. This folder might not 
exist on all systems. Its folders contain source code that you can study 
and compile. 

The NextLibrary folder contains resource files organized into several folders. Some of the 
files and folders aren't on every system. Typical folders include 
/NextLibrary/Documentation, which holds NeXTSTEP technical documentation, and 
/NextLibrary/Fonts, which holds the PostScript fonts available to all applications. 
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Local and Personal Folders 

The four folders with a "Next" prefix can be matched by four identical folders with a 
"Local" prefix. Internally, these four folders should be organized like their "Next" 
counterparts. But instead of containing files supplied by NeXT, they should hold 
information and applications provided for all users at a local site. Any user who logs in to 
a machine, or boots from it over a network, has access to its "Local" folders. If you add a 
new font for all users of your network, for example, it would reside in 
lLoealLibrarylFonts. 

"Local" folders are created as they're needed. They aren't included on the release disk. 

Users can add unprefixed Library and Apps folders in their home folders to hold 
information and applications that they alone have access to. Users who develop utilities for 
their own use or purchase private copies of a word processor and spreadsheet, for example, 
should put them in -/ Apps. 

Net 

The Net folder gives the user access to file systems that are physically located on remote 
machines. The immediate folders under Net name the machines where the file systems are 
located. The next level of folders name the root folders of the file systems on those 
machines. For example, !Net/willow/mise is where the mise file system located on the 
willow computer would be mounted. 

Net contains folders only if the user's computer is set up to be connected to other machines 
over a network. 

All the folders in the root (I) folder, including Net, are physically located on the disk that 
the user's machine was booted from. If a user boots from a local hard disk, for example, 
NextLibrary and all its folders will be stored on the local disk. Remote folders are 
mounted only under Net. 
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Paths 

The Workspace Manager searches for executable files by using a search path, an ordered 
set of folders. The default path used by the Workspace Manager lists these six folders: 

-IApps 
/LocalApps 
INextApps 
INextDeveloperl Apps 
INextAdmin 
INextDeve1operlDemos 

The Workspace Manager uses this path for three tasks: 

• To find the icons it should display for files associated with a particular application. 
• To find the application it should start up when the user double-clicks a file. 
• To find services offered by applications. 

Before using the search path to find which application to start up, the Workspace Manager 
first looks in the dock. Each application icon in the dock represents a particular application 
residing in a particular folder on disk. By putting an icon in the dock, the user has indicated 
a preference for that version of the application over any others. 

If an application isn't in the dock, the Workspace Manager looks next in the current 
working folder, the folder containing the file the user wants to open. Only after failing to 
find the application there does it tum to the path listed above. 

In the path, the Workspace Manager looks first in the Apps folder of the current user's home 
folder. That's where the user's own applications would be. It next looks in the ILocalApps 
folder for sitewide software, then in the lNextApps, /NextDeveloper/Apps, lNextAdmin, 
and lNextDeveloperlDemos folders for NeXT-supplied software. This ordering of folders 
lets users customize their software to override sitewide software, and lets sitewide software 
override software supplied by NeXT. 

Users can alter the path shown above for the Workspace Manager by setting a value for the 
ApplicationPaths parameter in their defaults database. You might do this, for example, to 
add a ILocalAdmin or ILocalDeveloperl Apps folder to the path. 
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File Name Extensions 

NeXTSTEP applications use file name extensions to identify types of files. The extension 
consists of the last period in the file name and all characters following it. For example, Mail 
uses the" .mbox" file name extension to identify its mailboxes. Typical mailbox names are 
Active.mbox and Outgoing.mbox. 

The Workspace Manager uses file name extensions not only to identify particular types of 
files, but also to associate document files with applications. Every application that defines 
its own data file format appends an identifying extension to the names of its document files. 

File Packages 

Afile package is a folder that the Workspace Manager presents to users as if it were a file. 
Because users normally don't look inside a file package (unless they explicitly open it as a 
folder), they're not likely to alter or reorganize its contents. "Using File Packages," later in 
this chapter, describes when you should use file packages. 

Using Paths 

If your application needs to look up data that could be in several places on the system, it 
should use an ordered path similar to the one used by the Workspace Manager. For 
example, if an application requires a particular template file that might be supplied either 
by the user or by the system administrator, it should search for it first in a folder under 
.... !Library, and then in the same folder under !LocaILibrary. 
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Using FiDe Name !Extensions 

Your application should use its own unique file name extensions to identify (and help the 
Workspace Manager identify) its documents. Your extension (after its initial period) can 
include only alphabetic and numeric characters and should be at least three characters long. 
(NeXT reserves all extensions of under three characters for its own use.) For example, 
".example" is an acceptable extension, but ".eg" is not, since it has only two characters after 
the period. 

To request that an extension be registered and reserved for your use, write to: 

NeXT Technical Services 
Extension Registry 
900 Chesapeake Drive 
Redwood City, CA 94063 

You can also send your request by electronic mail to ask_next@NeXT.COM or 
.. .! next ! ask_next. 

The request should include the following information: 

• The file name extension you want to register. List a first and a second choice. 
• The name of the application the request is for. 
• Your name and the name of your company. 
• Your postal address and your electronic mail address, if you have one. 
• Your telephone number. 

You'll be informed when the extension is registered, or if it can't be for any reason. NeXT 
Technical Services will make the list of registered extensions available to you so that you 
can choose an extension not already assigned. 

Registering a file name extension reserves it for your use. If you fail to register an extension 
that you intend to use, someone else may register and use it instead. 
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Using File Packages 

An application should create a file package when it has a group of files that it needs to keep 
together. For example, if your application displays information that's stored in independent 
text files, or if it makes use of a private utility program, or if it just loads archived objects 
from Interface Builder ".nib" files, you may want to keep these auxiliary files in close 
proximity to the application executable file. A file package (with the ".app" file name 
extension) is the way to do it. 

Similarly, if your application creates documents that are split into more than one file-for 
example, if text is in one file and artwork in another-these files can also be grouped in a 
file package. 

File packages for documents should bear the same extension that's assigned to the 
application's document files. For example, if a word processor uses a file package to store 
a document that has artwork, then the file package's extension should be the same as if the 
document had no artwork and was thus in a single file. 

Opening and naming files within a document file package is entirely the application's 
responsibility. 

Creating Unrequested Files and Folders 

Applications sometimes need to create files and folders for a user, other than as the result 
of a Save command. 

If the files are associated with a particular document, they should be grouped with that 
document and placed in a file package. 

Otherwise, where the files are located and what they're named depends on whether the user 
needs to have direct access to them: 

• If the user never needs to get at the files or folders independently of using the application 
that creates them, they should be placed in a folder named .... /.Applnfo. If an application 
needs to create many such files, it should put them in its own folder in .... /.Applnfo. For 
example, if an application named My App needs to create many unrequested files, it 
should put them in a folder called .... /.Applnfo/My App. If the .... /.Applnfo folder doesn't 
already exist, the application should create it. 
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• If the user might sometimes need to get at the files or folders independently of the 
application that creates them (for example, template files), they should be placed under 
-/Library. You should name each file or folder so that the user can easily tell which 
application put it there. 

The guiding principle here is that the user's home folder belongs to the user. An application 
shouldn't leave anything there that belongs to it, not to the user. When the application must 
create unrequested files and folders, it should put them where the user can find them but 
where they aren't likely to get in the user's way. 

Note: You should generally use the defaults system instead of files to store small amounts 
of data.· The functions supporting the defaults system are described in the NeXTSTEP 
General Reference manual. 

Displaying File Names 

File names are often displayed in a browser, where the user can see the path leading to the 
file. However, sometimes it's necessary to use only text for the file's name and path. In this 
case, the file's name should usually be displayed followed by two spaces, an em dash, two 
more spaces, and then the path. For example: 

job Records - INet/machine/home/records 

However, when there isn't much space to display the file name-as in a menu command­
the path can be shortened to the minimum necessary to differentiate the file name. The part 
of the path that isn't shown should be replaced with three dots. 

For example, if one file called jobRecords is listed in limited space, it should be listed as: 

jobRecords 

If two files called jobRecords are listed in limited space, they might be listed as: 

job Records - .. ./records 
job Records - .. ./backup 
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Suggested Reading 

User Interface Concepts 

A number of books, papers, and articles describe user interface concepts. A few books are 
listed below. Their bibliographies can lead you to other sources. 

The Art of Human-Computer Interface Design. Brenda Laurel, editor. Addison-Wesley, 
1990. 

The Design of Everyday Things. Donald Norman. Doubleday, 1990. 

Designing the User Interface: Strategies for Effective Human-Computer Interaction. 
Ben Shneiderman. Addison-Wesley, 1987. 

Tog on Interface. Bruce Tognazzini. Addison-Wesley, 1992. 

Another resource is the Special Interest Group on Computer and Human Interaction 
(SIGCHI), a subgroup of the Association for Computing Machinery (ACM). For more 
information about ACMlSIGCHI, such as the chapter nearest you, contact them at the 
following address: 

Association for Computing Machinery 
Membership Services Department 
1515 Broadway 
New York, New York 10036 
U.S.A. 

Telephone: (212) 626-0500 
Fax: (212) 944-1318 
Electronic mail: ACMHELP@ACMVM.BITNET 
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NeXTSTEP Programming 

NeXTSTEP General Reference: Release 3. NeXT Publications. Addison-Wesley, 1992. 

NeXTSTEP Programming Inteiface Summary: Release 3. NeXT Publications. 
Addison-Wesley, 1992. 

The two books above present the programming interface for NeXTSTEP applications. 

NeXTSTEP Development Tools and Techniques: Release 3. NeXT Publications. 
Addison-Wesley, 1992. 

See the back cover of this manual for more titles in the N eXTSTEP Developer's Library. 
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Glossary 

active application 
The application currently associated with keyboard events. Menus are visible on-screen 
only for the active application, and only the active application can have the current key 
window and main window. 

anchor point 
When the user drags to define a range, the position of the cursor when the mouse button is 
pressed. See also end point. 

application 
A program with a graphical user interface that the user can run from the workspace, such 
as Edit, FaxReader, or Preferences. 

application dock 
The column holding application icons at the right of the screen. 

Application Kir' 
The Objective C classes and C functions available for implementing the NeXT 
window-based user interface in an application. The Application Kit provides a basic 
program structure for applications that draw on the screen and respond to events. 

arrow key 
One of the four keys with arrows on them, to the left of the numeric keypad on the NeXT 
keyboard. They move the insertion point in the indicated direction. 
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auach 
To choose a menu command that controls a submenu, causing the submenu to appear 
on-screen next to the supermenu (the menu with the controlling command). Moving or 
closing a supermenu also moves or closes its attached submenu; choosing the controlling 
command a second time detaches and hides the submenu. 

attention panel 
A panel that demands the user's attention. Until the user acts to dismiss the panel from the 
screen, no other action within the application is possible. Attention panels permit the user 
to rescind a command (such as Close), ask the user to complete a command (such as Save 
As), and give warnings that the user must acknowledge. See also panel and ordinary panel. 

background color 
In the Application Kit, the color that fills the content area of a window and provides a 
background for all the drawing done within the window, or the color that fills a View as a 
background for any drawing the View or its subviews do. 

bar 
The part of a slider or a scroller that holds ~he moveable knob. See also knob. 

busy cursor 
The cursor image (a spinning disk) that indicates that an application is busy. 

character code 
The code that identifies a character in a given character set; an index into the character set's 
encoding vector. 

character keys 
The keys that transmit characters to the NeXT computer. This includes not only the usual 
letters, numbers, and symbols, but also Return, Enter, Delete, Tab, Esc, and the arrow keys. 

character set 
The set of characters for a particular font or fonts; either the NeXTSTEP character set (an 
extension of ASCII) or Symbol. 

class 
In the Objective C language, a prototype for a particular kind of object. A class definition 
declares instance variables and defines methods for all members of the class. Objects that 
have the same types of instance variables and have access to the same methods belong to 
the same class. See also class object. 



click 
To press and release a mouse button while the cursor is positioned over an object on-screen. 
Clicking an object may select it or cause it to act in some way. Users can also click to select 
a particular location (for the insertion point, for example). 

close button 
The button that can appear at the far right in a window's title bar. Clicking the button closes 
the window (removes it from the workspace). 

content area 
The area within a window that's available for the application to use. It excludes only the 
window's border, title bar, and resize bar. 

controls 
Graphical objects-such as buttons, sliders, text fields, and scrollers-that the user can 
operate to give instructions to an application. 

cursor 
The small image (usually an arrow) that moves on the screen correspondingly as you move 
the mouse. 

delegate 
In the Application Kit, an object that acts on behalf of another object. Window, 
Application, Text, Listener, NXBrowser, NXImage, and other objects can be assigned 
delegates. 

directory 
See folder. 

dock 
See application dock. 

docked icon 
An icon in the application dock. 

document window 
A window that displays the contents of a user-created file. 

double-click 
To press and release a mouse button twice in succession while the cursor is positioned over 
an object on-screen. To count as a double-click rather than as two separate clicks, the 
mouse cannot move and the mouse button must be pressed the second time within a short 
interval of the first. 
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drag 
To move the mouse (and the cursor on screen) while a mouse button is held down. 

endpoint 
When the user drags to define a range, the position of the cursor when the mouse button is 
released. See also anchor point. 

event 
The direct or indirect report of a user's action on the keyboard or mouse. 

event mask 
A long integer associated with a window. It controls which types of events will be 
associated with the window and passed to the application that owns the window. A 1 in 
the bit corresponding to a particular event type means the window will accept that type 
of event. 

file 
A collection of related information stored on a disk, such as a document, report, letter, 
or application. 

file package 
A folder that the Workspace Manager presents as a file, allowing the user to manipulate a 
group of files as if they were one file. A file package for an application executable should 
have the same name as the executable file, plus a ".app" extension. File packages for 
documents should bear the same extension as the one assigned to the application's 
document files. 

file system 
The collection of all the files the user can access through the computer. 

floating panel 
A panel, such as a palette, that stays in front of standard windows and other panels. See 
also tiers. 

folder 
A place in the file system that contains files and other folders. In documentation for 
programmers, folders are usually called directories. 

freestanding icon 
An application icon standing alone in the workspace. Freestanding icons represent running 
applications and can be dragged into the dock. See also docked icon. 



highlight 
To make something such as a command, text, icon, ottitle bar stand out visually. 
Highlighting usually indicates that something has been chosen to perform an action, or 
selected to receive an action. 

hot spot 
The point in the cursor image whose location on the screen is reported as the cursor's 
location. The cursor is said to be "over" the location at its hot spot. 

insertion point 
The point where whatever you type or paste in an application will be inserted. In text, it's 
typically marked by a blinking vertical bar. 

inspector panel 
A panel that displays information about the object that's currently selected. 

Interface BuilderTlA 

A tool that lets you graphically specify your application's user interface. It sets up the 
corresponding objects for you and makes it easy for you to establish connections between 
these objects and your own code where needed. 

key-down event 
An event that occurs when the user generates a character by pressing a key. Holding the 
key down generates subsequent key-down events at regular intervals. 

key equivalent 
In the Application Kit, the character that can be used as the keyboard alternative for a 
given object. 

key-up event 
An event that occurs when the user releases any key except Alternate, Shift, Control, 
or Command. 

key window 
The window in the active application that receives keyboard events. The title bar of the key 
window is highlighted in black. 

keyboard alternative 
A way of using the keyboard, rather than the mouse, to choose a menu command, operate 
a button in a panel, or pick an item from a pop-up or pull-down list. While holding a 
Command key down, the user types a character associated with the command, button, or 
item. See also key equivalent. 
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knob 
The part of a slider or scroller that the user can drag. See also bar. 

linked information 
Copied infonnation, such as a graphic image, that can be automatically updated when the 
original information is modified. 

main menu 
The principal menu in an application, usually identified by the name of the application in 
its title bar. The main menu lacks a close button and cannot be made the submenu of 
another menu. 

main window 
The standard window that's affected by actions in a panel and certain menu commands. If 
the main window isn't also the key window, its title bar is highlighted in dark gray. 

menu 
A small window that displays a list of commands. Only menus for the active application 
are visible on-screen. 

message 
In object-oriented programming, the method selector (name) and arguments that are sent to 
an object; the message tells the receiving object what to do. 

method 
In object-oriented programming, a procedure that can be executed by an object. 

miniaturize button 
The button that can appear at the far left in a window's title bar. Clicking the button 
removes the window from the screen and replaces it with its miniwindow counterpart. 

miniwindow 
A small, icon-sized window that stands in for a window that has been miniaturized. 
Double-clicking the mini window reverses the miniaturization, returning the full window to 
the screen. 

mode 
A period of time when the user's actions are interpreted in a special way. 

modifier keys 
Keys that change the meaning of other keys or of the user's actions with the mouse; the 
Shift, Alternate, Command, Control, and Help keys. 



mouse-down event 
An event that occurs when the user presses a button on the mouse. There's one type of 
mouse-down event for the left (or only) mouse button and one for the right button. 

mouse-dragged event 
An event that occurs when the user moves the mouse while holding down a mouse button. 
There's one type of mouse-dragged event for when the mouse is moved with the left (or 
only) mouse button down, or with both buttons down, and another type for when it's moved 
with the right button down. 

mouse-moved event 
An event that occurs when the user moves the mouse without holding down a mouse button. 

mouse scaling 
The responsiveness of the cursor to movements of the mouse. Usually, the faster the mouse 
is moved, the farther the cursor travels. 

mouse-up event 
An event that occurs when the user releases a mouse button. There's one type of mouse-up 
event for the left (or only) mouse button and one for the right button. 

multiform panel 
A panel that has a pop-up list or set of graphical radio buttons at the top that lets the user 
choose which form the panel takes. 

multitasking 
Describes an operating system that allows the concurrent execution of multiple programs. 
Mach, the operating system of all NeXT computers, is multitasking. 

NeXTSTEpn. 
NeXT's application development and user environment, consisting of the Workspace 
Manager, various applications such as Project Builder and Interface Builder, various 
software kits such as the Application Kit and the Database Kit, and the Window Server. 

object 
A programming unit that groups together a data structure (instance variables) and the 
operations (methods) that can use or affect that data; the central focus of object-oriented 
programming. 

one-state button 
A button that initiates actions, as opposed to one that sets a state. Also known as an action 
button. See also two-state button. 
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ordinary panel 
Any panel that isn't an attention panel. See also attention panel and panel. 

panel 
A window that holds objects that control what happens in other windows (such as a Font 
panel) or in the application generally (such as a Preferences panel), or a window that 
presents information about the application to the user (such as an information panel). See 
also attention panel and ordinary panel. 

pixel 
The smallest unit that can be assigned a color or coverage value for showing images on the 
screen or printed page. 

pop-up list 
A menu-like list of items that appears over (or next to) an on-screen button when the button 
is pressed. The user can choose an item by dragging to it and releasing the mouse button. 
When the mouse button is released, the pop-up list disappears. 

press 
To press a mouse button and keep it down for a period of time while the cursor is positioned 
over an object on-screen. Pressing an on-screen object (such as a scroll button) may cause 
it to take repeated action, or may produce another object (such as a pop-up list) that the user 
can drag into. 

Project Builder 
A tool that lets you create and maintain your application's project and source file hierarchy. 
Project Builder provides a user interface for building your application from its source files., 
as well as connections with other NeXT developer applications for interactive debugging. 

pull-down list 
A menu-like list that appears under an on-screen button when the button is pressed. The 
user can drag into the list to choose an action from it. When the mouse button is released, 
the pull-down list disappears. 

resize bar 
The bar, located along the bottom of a window, that the user can grab and drag to resize 
the window. 

scroll buttons 
Any of the buttons that the user can press to scroll a display, such as the buttons in a 
scroller. Each scroll button is labeled by a small triangular arrow indicating the direction 
of scrolling. 



search path 
An ordered set of folders used by programs to search for files or folders. 

standard windows 
The principal windows of an application; the windows where its primary work is done. 
All windows are standard windows, except those with specialized functions (menus, 
panels, pop-up and pull-down lists, miniwindows, and docked and freestanding icons). 

submenu 
Any menu that can be brought to the screen through a command in another menu. All 
menus except the main menu are submenus of another menu. See also supermenu, 
main menu, and attach. 

supermenu 
A menu containing a command that controls another menu, its submenu. 

system control keys 
The keys that control the computer's basic functions; the Power, brightness, and volume 
keys. 

target 
In the NeXTSTEP user interface, what the user selects to be acted on by a menu command 
or a control within a panel-for example, text that's to be deleted by the Cut command. In 
the Application Kit, the object that receives action messages from a Control. 

tear off 
To drag an attached submenu away from its supermenu. Tearing off a submenu detaches it 
from its supermenu and gives it an independent life on-screen. Tom-off menus are the only 
menus with close buttons. 

tiers 
The sections of the screen list. Each tier is occupied by a different type of window, with 
spring-loaded windows such as pop-up lists in the frontmost tier, attention panels in the 
second tier, menus in the next two tiers, docked icons in the tier below menus, and floating 
panels below docked icons. All other windows are in the bottom tier. 

triple-click 
To press and release a mouse button three times in succession while the cursor is positioned 
over an object on-screen. The mouse button must be pressed the second time within a short 
interval of the first, and the third time within a short interval of the second. 

two-state button 
A button that sets a state, as opposed to initiating an action. See also one-state button. 
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Window Server 
A process that dispatches user events to applications and renders PostScript code on behalf 
of applications. 

windows 
Page-like rectangular areas where applications can draw on-screen. Windows can be 
moved and reordered front to back. 

workspace 
The screen environment in which the user works on a NeXTSTEP computer. 

workspace window 
The window that fills the entire workspace on the screen and provides the dark gray 
background for other windows. 
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Control key 
as modifier key 23 
use with arrow keys 49 
using with mouse 45 
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Edit menu 112, 118-119 
programming notes on 119 
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Find panel 89,92 
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programming note on 126 
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Format menu 112, 124 

Heavier command 126 
Help command 35, 115 
Help key 

alternative when keyboard has no 46 
as modifier key 23 
using with mouse 46 

Help panel 89, 93 
Hide command 35, 113 
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Info menu 112, 115 
Info panel 89, 95 
Info Panel command 115 
Italic command 35, 125 

Jump to Selection command 36, 123 
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keyboard 
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recommended 36 
required 35 
reserved 34-35 
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adding to 114 
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main window 59,63-64,65 
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implementing 106-110 
programming note on the Application Kit 

and 102 
role of 5 
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tier of 53, 54 
uses of 99 

miniaturize button 6,55, 70 
Miniaturize Window command 36, 129 
mini windows 6 
modal tool 19 
modes 
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mouse 
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ordinary panels 4, 76. See also panels 
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Page Layout command 36,124 
Page Layout panel 90 
panels 4-5, 75-98. See also attention panels and 

ordinary panels 
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customizing Application Kit 88 
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status for 79 
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Paste command 35, 118 
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Paste Link Button command 121 
Paste Ruler command 36,128 
paths 161 

using 162 
pop-up lists 136 

buttons that control 9 
implementing 141 
tier of 53 

Preferences command 115 
Preferences panel 90, 96-97 
pressing 26 

when to use 44 
Print command 35, 113 
Print panel 90 
Publish Selection command 121 
pull-down lists 137 

buttons that control 8 
implementing 141 
tier of 53 



Quit command 35, 113 
Quit panel 90,97-98 

radio buttons 
graphical 135 
standard 135 

resize bar 70 
Return key 

use of 32 
using instead of a button 144 

Revert to Saved command 117 

Save All command 117 
Save As command 36, 116 
Save command 35,116 
Save panel 91, 98 
Save To command 117 
screen, typical NeXTSTEP 2 
scroll bar 148-149 
scroll buttons 149 
scroll knob 148-149 
scrollers 10, 147-151 

fine-tuning mode in 150 
how they work 148-150 
implementing 150-151 
parts of 148 
the user's view 150 
uses of 147 

scrolling 
automatically 150 
programming note on 149 

Select All command 35, 119 
selection 27-31 

by clicking 28 
by dragging 27 
by multiple-clicking 28 
continuous extension of 29 
discontinuous extension of 30 
extending the 28-30 
implementing 47-50 
of a range by dragging 43, 48 
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Services menu 113, 130-131 
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programming note on 131 
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Shift key 

as modifier key 23 
use with arrow keys 49 
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using with mouse 45 

Show Links command 121 
Show Menus command 115 
Show Ruler command 36, 128 
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current value of 145 
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programming note on implementing 
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Smaller command 126 
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removing from screen 104 
tearing off 103 

Subscript command 126 
Superscript command 126 
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targeted action 18 
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Textmenu 124,128 
title bar 55 
Tools menu 132 
triple-clicking 25 

Unbold command 35,125 
Underline command 126 
Undo command 35,119 
Unitalic command 35, 125 
Unscript command 126 
Ununderline command 126 
user interface 
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Index 183 



user interface (continued) 
design philosophy 13-20 
direct manipulation paradigm 17 
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paradigms for using mouse in 17-19 
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targeted-action paradigm 18 
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use of mouse in 16 
user control of 14 
visual guide to 1-11 
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control of user interface 14 
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and applications 59-66 
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